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Preface

This manual describes how to use the Palace User Software for Windows 95/98/NT 
client and be a member of the Palace community. It is especially designed for new 
users to get them up and running. However, advanced users will also find this manual 
useful since it describes advanced Palace features, and is a reference for the client 
graphical interface.

Sections of this manual

This manual has the following sections:

• Introduction

This section introduces the Palace community and Palace User Software.

• Getting Started

This section guides you through installing your software and getting your client up 
and running.

• Connecting to Palace Sites

This section explains how to connect to different Palace sites so you can start 
exploring the Palace community.

• How to Use the Palace

This section explains the Palace features and how to use them: your avatar, talking 
to and finding other people, props, and moving around.

• The Palace Client Interface

This section is a reference for the Palace User Software graphical interface, 
describing its menus, tools, icons, and keyboard shortcuts.

• The PalacePresents Viewer

This section describes the PalacePresents Viewer. This Palace plugin allows you to 
take part in large-scale networked events such as conferences, guided web tours, 
slideshows, live interviews, lectures and other “one-to-many” interactions.

• Advanced Features

This section describes advanced features that you will want to try when you get 
more acquainted with the Palace: special commands, Iptscrae, and creating 
member rooms.

• Quick Reference

This section lists some suggestions on what to do to get going in the Palace. 
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In addition, several appendices are included:

• Appendix A: Community Standards

• Appendix B: User Command Summary

• Appendix C: The Palace Client Plugin API

Manual conventions
This manual has the following conventions:

• Code samples and text you enter are set in Courier , whether standing alone or 
embedded in the text.

• Technical terms appear in boldface italic in the text in their first appearance, 
usually accompanied by a definition. 

• Graphical User Interface (GUI) elements, such as menu items and buttons, appear 
in boldface.

• References to other books, chapters, or sections are in Italics.

NOTE – Notes to the user look like this.

Other sources of information
Besides this User's Guide, the Palace provides other related manuals for administering 
your server, becoming an operator, and mastering Iptscrae. These manuals are all 
available from the Palace website.

• Palace Server Guides. These manuals tell you how to obtain, install, setup, and run 
your own Palace server. A Macintosh, UNIX, and Windows 95/98/NT version are 
available.

• Operator's Guide. Describes the responsibilities of an operator (formerly known as a 
wizard), and details the Palace client's operator interface and commands.

• Iptscrae Language Guide. This manual is a programming and language reference 
guide for the Palace Iptscrae language.

In addition to the Palace online manuals, check out the Palace website for support, 
information, and online documentation: http://www.thepalace.com.
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1 Introduction

Welcome to the Palace - a vast online community of graphical interactive sites. With the 
Palace User Software client as your gateway, the variety of Palace destinations you can 
explore is limitless. You can visit a diverse range of communities such as business, 
training, and learning resources; entertainment and gaming centers; gathering points 
for special interest groups; and also personal sites where you simply can go to chat and 
socialize with friends and family. If you download the Palace Server, you can even 
build and customize your own personal Palace site to host other people. An eight-user 
version is available for free on the Palace website (www.thepalace.com ).

One of the best things about the Palace is that it is an open system, letting you create 
and control much of your site’s content. The Palace User Software client not only 
functions as a front-end to browse the Palace community, but also does double-duty as 
a full-fledged authoring tool. By using the built-in "operator powers", available Palace 
tools, and the Iptscrae scripting language, you can create your own virtual world and 
share it with others. The system also ensures that all Palace sites can be interlinked. 
This means that you can build new rooms and sites, and then connect them to other 
Palace sites using various networking options. You can even create links between 
Palace sites and web pages, making it all that much easier for people to find you!

The Palace community is a client/server system, with Palace sites running on 
individual computers, local area networks, and the Internet. You enter a Palace site 
through your Palace client, which is designed to communicate with any Palace server 
running on another (or even the same) computer. This is similar to the way your web 
browser interfaces with "webservers" while surfing the Internet.

The Palace allows users to communicate effortlessly over various types of networks. 
You can run your Palace software on either a TCP/IP-based LAN or on the Internet via 
a SLIP or PPP connection. Palace sites running on Local Area Networks hooked to the 
Internet will allow interaction between people on the LAN and folks coming in via the 
Internet.
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2 Getting Started

This section describes how to get started using your Palace client:

• Requirements on page 11

• Logging on for the first time on page 13

• Installation on page 12

• Logging off on page 15

Requirements

The Palace User Software has the following requirements:

Computer: Pentium processor running Windows 95, Windows 98, or Windows NT 
(version 4.0 or newer).

RAM: At least 32 megabytes.

Monitor: 16bit High color with 800x600+ support.

Disk space: At least 10 megabytes. If you plan on traveling to other Palace sites, be 
aware that many of these servers have their own original artwork and sounds. As you 
enter new rooms in these servers, you might need additional hard disk space to store 
these additional assets.

Connectivity: 28.8kbps (or greater) connection to the Internet. 

Browser: You need a Web browser to access user profile and Palace site pages. Either 
Netscape or Internet Explorer, version 4.x or better is required.
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Installation

NOTE – Before using the Palace User Software client, you should obtain a registration 
code to unlock the full features of the software. This code is free. Be sure to register 
before you download; you can access the registration form from the software 
downloads page.

Don't give out your registration code! A Palace server does not allow two users with 
the same registration code to connect at the same time. This means if somebody else 
uses your code, you might be locked out of Palace sites all over the Internet. 

The Palace client contains several related files including executable programs, 
graphics, sounds, prop files and script files. All of these assets are distributed in a 
single, self-extracting archive file.

To obtain the Palace client software, select it from the Downloads page at the Palace 
website (http://www.thepalace.com/downloads).  The downloads process steps you 
through registration, and then downloads the install file to your machine. You can then 
click on the downloaded file to begin installation.

After the software installs, the Palace client launches automatically. You can choose to 
enter your registration code at this time to become a full-fledged member. The 
registration code was emailed to you after you completed the registration form online. 
If you choose not to register at this time, you can register later by selecting Enter 
Registration Code from the File menu.

Updating your software
Palace upgrades are released fairly regularly. Be sure to visit the Palace website 
periodically for updated versions. Here’s how to do it:

1. Determine which version you’re currently using. To do this, select About The 
Palace in the Help Menu.

2. To grab the newest updated version (or just to check for one), select Software 
Updates from the Help Menu. This will launch your web browser and send you to 
the appropriate page on the Palace website.

3. Download the current software executable to your machine, and then install it.
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Logging on for the first time 

Logging on for the first time

You are now ready to log on to a Palace site and start socializing with other members! 
Your client is automatically launched when you first install it. If you exited and now 
wish to log on again, select Programs:The Palace:The Palace32 from your Windows 
Start menu. You access the Welcome Palace as your first site, entering the Welcome 
Palace gateway as the first room. 

To see a sample Palace room illustrating various parts of the user interface, see 
Elements of the main window on page 39.

NOTE – To bring up the Toolbox if it does not appear yet, press Control-T.

Learning on your own with the Welcome Palace Gate
The Welcome Palace gateway is your default entrypoint into the Palace. When you 
enter the Welcome Palace gate using The Palace User Software, the Web browser on 
your machine also launches to the Palace's web page, where you can find links to other 
exciting Palaces. Note that if you later enter the Welcome Palace using a bookmark 
under the Bookmarks menu, you enter a different room and the web browser is not 
automatically launched. 

The Welcome Palace gateway is private, and you are the only user. You can use this 
room to get comfortable with the basic layout of the Palace software user interface. 

The Welcome Palace gate has several links:

• Avatar Dispenser

• Palace Web page 

• Practice Palace

• Welcome Palace Site

NOTE – The Welcome Palace gateway is your default entry to the Palace community 
until you change it. See Connecting to Palace Sites on page 17 for information on 
bookmarking Palaces, connecting to new Palaces, and creating a Home Palace from the 
Edit:Preferences window.

Avatar Dispenser 

In The Palace, your onscreen representation is referred to as your avatar. You first 
come into the Palace wearing a default avatar. Use the Avatar Dispenser to change 
your appearance.
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To change your image, click on the Avatar Dispenser's Change your appearance 
button. The image that represents you will change. Continue clicking this button until 
you find an image that you like. You can also click the Back button to go back to a 
previous Avatar. The Dispenser will loop back to the beginning after displaying the 
final avatar.

If you would like to change your appearance again later, go to the Avatar Palace. To go 
to this Palace, select Avatar Palace from the Palaces menu.

Palace Web Page

Clicking this link opens a new browser window displaying the Palace Channels Guide.  
Here you can find links to hundreds of other exciting Palaces, and lists of Events held 
in Palaces.

Installing The Palace User Software automatically launches your Web browser to this 
web page. You can use this button to relaunch your web browser if you have closed the 
web page.

The Practice Palace

Click this link to access the Practice Palace. This is an interactive tutorial that teaches 
you how to do different things in the Palace. When you are finished, click the Palace 
icon (P) to go back to the Welcome Palace gateway. You can return to the Practice 
Palace by selecting Practice Palace under the Bookmarks menu. 

Entry to the Welcome Palace

Click this link to enter the Welcome Palace itself and socialize with others. The 
Welcome Palace is a site for new users, where you can meet people and learn more 
about the Palace community in general. 

NOTE – To make navigating through the Welcome Palace easier, try turning on door 
outlines. This way, you won’t "fall" through a door by mistake and end up in another 
room. Click the Show Doors image on the Toolbox to do this (if the Toolbox isn’t 
showing, press Control-T.)

Talking, moving around, and other actions
Here is a list of some things you’ll want to do next in the Palace. For other ideas, see 
the Quick Reference on page 77.

• To talk to people, click on the Input Box at the bottom of your screen (you may first 
have to press the Tab key activate the Input Box), type something, and press Enter. 
Your text will appear in a cartoon-balloon near your head. Talking and balloons is 
described in more detail in Talking to people on page 30.
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Logging off 

• To move around, see Moving around on page 35.

• You can personalize some of your Palace settings; for example, you can 
automatically display user names and have tinted word balloons. Use the 
Edit:Preferences menu item to customize these session in your Preferences 
window (see Preferences on page 46).

• If you would like to get a new avatar look, you can visit the Avatars palace. Select 
Bookmarks:Avatars for this menu item.

Logging off

There are several ways to leave your current Palace site:

• To go to another Palace, see Connecting to Palace Sites on page 17.

• To disconnect from any Palace site, but not shut down the Palace User Software, 
select Disconnect from the File menu. You are able to still access Palace features 
such as editing props.

• To disconnect and close the Palace User Software altogether, select Exit from the 
File menu.
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3 Connecting to Palace 
Sites

There are a number of different ways to access Palace sites. This section explains the 
options available to you:

• If you already have a Palace User Software client running on page 17

• From your web browser on page 18

• Returning to a recently-visited Palace on page 19

• Using other online services on page 19

If you already have a Palace User Software client 
running

If you are already running the Palace User Software client, there are several ways to 
connect to different Palace sites:

• Click the Connect To a Palace button in the Toolbox, or select Connect to a Palace 
from the File menu. This displays the Connect window. In the Palace Server 
Address field, either select from a drop-down list of Palaces, or type the address of 
a new Palace (for example, test.communities.com) , or the machine's IP address 
(such as 205.999.99.99) . If the port number of your destination is not the default 
(9998), enter the correct port. 

If you want to connect to your own Palace server that is on the same machine as 
your client, enter 127.0.0.1  or localhost  in the Connect window. This is the 
Palace local host address, and lets you connect to your local server without having 
to go through an Internet Service Provider (ISP).

• Use the Bookmarks menu to choose from a list of Palaces. You can also select the 
Palace Directory option to access the Palace Site Directory (a list of publicly 
available Palaces on the Palace website)
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• If you have already bookmarked the Palace you want to visit, you can return there 
via the Bookmark window. To open this window, select Bookmarks... from the 
Bookmarks menu (see Returning to a recently-visited Palace on page 19).

• The Edit:Preferences window lets you set a “Home Palace” where your Palace 
travels will always begin (like a "Home Page" on the world wide web). For more 
information on the Preferences window, see Preferences on page 46.

• Some Palace sites have "hot spots" in their rooms that link to other Palaces. If you 
know about one of these hotspots, you can click it to go directly to that Palace.

From your web browser

You can access Palace sites directly from the web if you know the address. You do not 
need to have your client running before entering a Palace site; it is launched 
automatically. 

• In your web browser, enter the address of the Palace you want to visit in the format 
machine.domain  (for example, test.communities.com) , or the machine's IP 
address (such as 205.999.99.99) .

• A Palace site operator might even give you an address to access a specific room in 
that Palace. This address includes the Palace server address, room ID, and optional 
port number (if the port number is not specified, your Palace client will assume it 
to be 9998). To go to that room, enter the address in your Web browser. 

This example illustrates the extended URL specification, where 89 is the room ID 
on the Palace server located at mansion.thepalace.com  (port 9997). 

Palace://mansion.thepalace.com:9997/89

• The Palace website (www.thepalace.com ) has several links that take you to Palace 
sites.  

• Periodically, certain Palaces are spotlighted in a Featured Palaces area.

• You can browse the list of the Top 100 Palaces.

• The Palace Site Directory lists all registered Palace sites (if they choose to be 
listed), even those which are not up and running. You can search for a specific 
Palace, choose one alphabetically, or browse Palaces by category (such as 
business or recreational). 

You can also access the Palace Directory from your private Palace Portal (see 
Logging on for the first time on page 13), or by selecting Palace Directory from 
your client’s Bookmarks menu.

If the Palace User Software icon appears next to the Palace listing (the red P), 
you can click it to go to that Palace. Or, click the Palace link itself to bring up 
its site page. From the site page, click Go using The Palace Software.
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Returning to a recently-visited Palace 

• Users might include Palace links on their profile pages; you can then click 
these links to go to that Palace. For information on accessing a user ’s profile 
page, see To see somebody else’s profile page on page 26.

Returning to a recently-visited Palace

The Palace client keeps a list of the last eight Palaces you’ve visited. To return to a site, 
select its address from the Connect window. To access this window, click on the 
Toolbox’s Connect To a Palace button (or select Connect from the File menu), and then 
click on the dropdown list button under Palace Server Address. To connect to one of 
the Palace sites shown on this dropdown list, select its name from the list and click OK.

You can also bookmark a Palace site to return to it quickly. When you are visiting a 
Palace site you wish to bookmark, select Add Bookmark from the Palace menu. Later, 
you can open your bookmark list by selecting Bookmarks from the Bookmarks menu.

Using other online services

If you don’t have a direct connection to the Internet, a number of online services 
provide a level of access suitable for running the Palace software. These services 
include America Online, CompuServe, and The Microsoft Network. 

America Online
1. Download and install the latest version of AOL.

2. Connect to AOL and start the Palace software using the instructions in Logging on 
for the first time on page 13.

CompuServe
1. Download and install the latest version of Wincim (GO WINCIM).

2. Start up the CompuServe Dialer, then launch the Palace software using the 
instructions in Logging on for the first time on page 13.

The Microsoft Network
1. Download and install MSN version 1.2 or later.



20 The Palace User Software Guide for Windows 95/98/NT

3    Connecting to Palace Sites

2. Double click on the MSN icon and choose Settings. In the Settings window, click 
Access Numbers; select Internet and The Microsoft Network for the Service 
Type. 

3. Connect to MSN and start the Palace software using the instructions in Logging on 
for the first time on page 13.



The Palace User Software Guide for Windows 95/98/NT 21

4 How to Use the 
Palace

This section describes various features of the Palace and how to use them:

• Avatars on page 21

• Talking to people on page 30

• Finding people on page 33

• Playing sounds on page 34

• Moving around on page 35

• Props on page 36

NOTE – In your Palace client, you might see different menu items for member versus 
guest features. Ignore these; if you have registered, you are a member. Also, the terms 
wizard and god are now referred to as operator and owner, respectively.

Avatars

Your onscreen representation is referred to as your avatar. You first come into the 
Palace wearing the default avatar, which is a spherical yellow happy face sometimes 
known as a roundhead or a yellowhead. You can change expression and face color on 
your roundhead avatar. Later, you might want to edit the look of this face, or get a new 
avatar completely.
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The avatar pop-up menu
Right-clicking on an avatar displays the avatar's pop-up menu. The options on this 
menu vary according to avatar: your own, somebody else's, and if you have operator/
owner capability.

NOTE – Always right-click above the avatar ’s name to get the menu; it won’t appear if 
you click below the name.

Other avatars’ menus

If you click on somebody else's avatar, you get the following menu:

Use this menu to enter whisper mode with the selected party, mute and unmute them 
(muting another user prevents their messages from displaying on your screen), or see 
their user profile page on The Palace website. You can also toggle user names in the 
View Screen between their visible and their invisible states with the Show/Hide 
Names option. 

The avatar pop-up menu is sensitive to your current membership status; operators and 
owners have more options available when they click on somebody's avatar to bring up 
that avatar pop-up menu. 

See The Palace Operator's Guide for information on these options.
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Avatars 

Your own avatar menu

Right-clicking on your own avatar displays the following avatar pop-up menu:

The options on your own menu let you quickly save or change avatars, wear props, 
select a new facial expression, edit your personal profile page on the Palace website, or 
change your user name.

Changing your name
When you first log on to the Palace, your default name is Guest. You can change your 
avatar name through the Welcome to The Palace window, which you access with any 
of the following methods:

• Change Name option on your avatar pop-up menu.

• Change Avatar Name from the Avatars menu.

• When you log on to the Palace client.

Enter the new name, or use the drop-down list to select a name, and click OK.

You can also change your name in the User Name field of your Preferences window 
(select Preferences from the Edit menu.)

Changing expression and color
You can change the expression and color for your default roundhead avatar through 
the Choose an Avatar window. To access this window, do one of the following:

• Click the Guest Avatars button in the Toolbox. 

Or

• Select Guest Avatars from the Avatars menu.

Or

• Select Change Expression from your avatar pop-up menu.



24 The Palace User Software Guide for Windows 95/98/NT

4    How to Use the Palace

From this window, click the expression you want and your roundhead avatar wears 
this new expression. You can keep this window while moving around in the Palace, so 
you can change your appearance almost instantly.

You can also type these expressions directly into your Input box at the bottom of your 
client window (if it's not activated, press the Tab key first or click in it) and then 
pressing Enter.

If you have an extended keyboard (with a separate numeric keypad on one side), you 
can use the plus and minus keys on the keypad to change your face color as well. Face 
colors can be used to great effect in signifying emotional states, especially when used 
in conjunction with appropriate expressions (for example: red plus the “angry” face or 
blue plus the “sad” face.) Simply click on your roundhead avatar, and then press the 
side keyboard plus or minus key to step through the different colors. 

Customizing your roundhead avatar
You don't have to keep your plain roundhead as your avatar. The Palace provides 
many standard props you can wear to customize your avatar. To change your avatar 
image altogether, see the next section, Creating a new avatar. 

When you type: You get:

:) or ) Happy

:( or ( Sad

:| or | Normal

;) or ; Winking

:[ or [ Angry
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Avatars 

• To update your roundhead by wearing new props, bring up your prop window 
(described in Your prop window on page 36) and select from your props which ones 
you want to wear. You can then save this avatar look in your Avatar window 
(described in Saving and wearing your new avatar on page 29), where you can access 
it quickly in the future.

• You can customize your avatar even further by coloring it and changing its look. 
Use the prop editor to do this (described in The prop editor on page 55).

Changing your avatar appearance
If you would like a new avatar image altogether, you can either create your own or 
obtain a new image from the Avatar Palace.

• To create a new avatar image, see Creating a new avatar on page 27.

• To obtain a new image from the Avatars Palace, select Avatar Palace from the 
Bookmarks menu.

Animating your avatar
You can animate your avatar (for example, have a blinking eye). You do this through 
your prop edit window (to open your prop edit window, open your prop window 
using the instructions in Your prop window on page 36, select a prop, and click Edit).   

Palace avatars have a fixed animation rate, and checking the Anim field of an 
individual piece will make the piece animate in rotation with any other of the pieces in 
the avatar that also have the Anim box checked. Since each avatar has a total of up to 
9 pieces, 9 is the maximum number of "frames" that can be animated in one avatar. 
Note that you must have two or more props marked Anim to do this.

Most people just animate a "section" of an avatar. For example, they will take a six-
piece avatar, and decide to animate something specific, such as an earring or winking 
eye. Use the following steps to do this:

1. Animate the avatar piece containing the prop you want to animate by marking it 
Anim in the prop edit window.

2. Save that change.

3. On the prop edit window, click Dupe to duplicate the prop. This duplicated prop 
will already have Anim checked. When both pieces are worn, they will animate.

4. You can use step 3 to make additional animating pieces.

NOTE – There's no elegant way to animate two completely different sections of one 
avatar, since they will alternate and produce a choppy effect.

Another setting in the edit window that can affect animation is the Bounce setting. If 
the animating pieces don't have Bounce checked, they will animate in the order they 
were put on in rotation, (1,2,3,4,1,2,3,4,1,2,3,4 etc.) If Bounce is checked, the pieces go 
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back and forth(1,2,3,4,3,2,1,2,3,4,3,2,1 etc.) Sometimes this can enhance the animation 
effect, and sometimes it's better not to use it. Experiment and see what works best for 
your prop.

Profile pages
Your Profile Page is a web page providing information such as your name, email 
address, favorite Palaces, and interests to other users. Every registered Palace user has 
a profile page. These are listed online at The Palace website’s Profile directory.

▼ To edit your own profile page

1. Do one of the following:

From your avatar menu (right-click on your avatar to bring up this menu), 
select Edit Profile Page.

Or
From your Palace client’s Edit menu, select Edit Profile Page.

2. Your web browser launches to your Profile Page Settings form. From here, you 
can edit settings such as your name, interests, custom picture, and a brief bio. Some 
special notes:

• You can link to Palace site pages and other users’ profile pages by entering 
their ID’s. If you do not know the specific ID for that person or Palace, click the 
Lookup link. When a user clicks on that link on your profile page, he or she 
accesses that person’s profile page, or that Palace’s site page.

• You can display a picture on your profile page, either your own or one 
provided by The Palace. If you use your own image, it must be hosted on a 
web server and be available even when you are not online. In the Picture URL 
field, enter the URL where the image is located.

• You can elect to not list your Profile page on the Profile directory, or prevent 
people from knowing where you are in the Palace at any given time. These 
fields are at the bottom of the Settings page.

3. When you are finished, click Update My Profile Page at the bottom of the form.

4. Click Edit My Palace Interests to update your list of interests.

▼ To see somebody else’s profile page 

1. Do one of the following:

a. From The Palace website, click Profile Directory to access the profile lookup 
page.

b. On this page, you can search for the user by name or profile ID.
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Or
a. If you are in the same Palace room as the user, right-click on their avatar 

(above their name) to bring up their avatar menu.

b. Select Open Profile page. Your web browser launches and goes to their profile 
page.

2. Once you have accessed that person’s profile page, you can do the following:

• Visit their palace by clicking the Palace link under My Palaces. To use your 
Palace User Software client, click the red encircled P.

• Send them email and visit their home web page by clicking the links under 
Mail and Home Page.

• Join them in the Palace community if they are online and allow you to do so. 
To do this, click join me!.

• Visit their favorite Palaces by clicking the Palace link under faves and 
raves:Palaces.

• See the profile pages of their friends by clicking the user name under Palace 
Buddies:

Creating a new avatar
The Palace lets you completely replace your roundhead with a new image for your 
avatar. You import your new avatar image as a graphic file, which you then save as a 
prop. Depending on how big this avatar prop is, you either save it in your prop 
window and wear it like any other prop, or save it as a grouped collection of props in 
your Choose an Avatar window (see Changing expression and color on page 23).

An avatar is really just a collection of props, including at least one head prop (a prop 
that replaces the default roundhead image). This head prop serves as a “centerpiece” 
for the rest of the avatar. A prop measures 44 by 44 pixels; an avatar can contain up to 
9 props (132 by 132 pixels). You can create your own avatars by importing bitmap 
graphic files that meet these size criteria. There are two ways to create your avatar, 
depending upon the size of the original image you’ve selected.

Single-Prop Avatars

If your avatar image is no larger than 44 by 44 pixels, it can be made into a single prop:

1. Open the desired image using any graphic editor.

2. Although the Palace software automatically selects the closest available colors 
when you paste in a graphic, you should pre-apply the 8-bit Palace Palette to the 
image while still in your graphic editor. This lets you fine-tune your graphics and 
avoid any undesired color shifts. The Palace Palette is free. It can be extracted from 
any of the default graphics provided with the Palace software, or downloaded 
from the Palace website. To extract the palette from a default graphic, consult the 
instructions in your chosen graphics editor.
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3. When your graphic is ready to import to the Palace, copy it into your Windows 
clipboard.

4. In the Palace software, open the prop editor (open your prop window by clicking 
the suitcase icon at the bottom right of the Palace View screen, and then click New 
on the resulting prop window). You don’t need to be connected to a Palace to do 
this.

5. Paste the image in the prop editor (Control-V). Edit the image as desired.

6. Make the image into a head prop by checking the Head field at the bottom of the 
prop editor. You may also want to name your new prop at this point.

7. Save your new prop by clicking OK. It now appears in your prop window, where 
you can wear it as a new prop. It will completely replace your current avatar.

Multiple-Prop Avatars

Your total avatar image can contain up to 9 props; that is, it can be up to 132 x 132 
pixels in size. The following diagram illustrates the total available area in which props 
may be worn: a square made up of nine single-prop-sized squares.

The Edit Menu contains a command called Paste Multiple Props. Use this option to 
create an oversized prop by pasting a single image:

1. Open the desired image using any graphic editor.

2. Although the Palace software automatically selects the closest available colors 
when you paste a graphic in, you should pre-apply the 8-bit Palace Palette to the 
image while still in your graphic editor. This will allow you to fine-tune your 
graphics and avoid any undesired color shifts. The Palace Palette is free. It can be 
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extracted from any of the default graphics provided with the Palace software, or 
downloaded from the Palace website. To extract the palette from a default graphic, 
consult the instructions in your chosen graphics editor

3. Select the area you want to use as your avatar, and copy it into your Windows 
clipboard.

4. In your Palace client, select Paste Multiple Props from the Edit Menu. The 
oversized image will automatically be cut into individual props and placed in your 
prop window. You don’t need to be connected to a Palace to do this, and you don’t 
need to open your Prop window. This command is not available while the Prop 
Editor is open.

5. The new avatar image is pasted into the prop window as individual 44x44 props 
(not necessarily in order).

6. If you want to edit an individual prop pane before wearing it, select it and click 
Edit to edit in the prop editor. In fact, you'll want to make at least one of these 
props into a head prop. When the desired image is in the prop editor, check the 
Head checkbox, and save your new head prop by clicking OK.

7. Save this grouped prop as a new avatar look just as you would any other avatar 
look in the Avatars window. You can then wear it at any time by selecting it from 
the Avatars window. See Saving and wearing your new avatar on page 29 for more 
information.

NOTE – No matter what size your avatar is, the default behavior of cartoon balloons is 
to appear from a point near the middle of the central cell (the position of the 
roundhead in the Prop Editor). Depending on where you want these cartoon balloons 
to appear from when you speak, you might want to place the individual pieces of your 
avatar manually (unless of course you like talking through your belly!)

Saving and wearing your new avatar
An avatar is a specific “costume,” including face color, expression and any props worn. 
If you have a "look" you like (for example, you are wearing special props, or have a 
new avatar image altogether), you can store this look for quick access when you want 
to change your appearance.

You do this through the Avatars window. To display this window, select Members 
from the Avatars menu, or Save/Wear avatars from your avatar pop-up menu. This 
window lets you store up to 22 avatars and instantly recall them, either by clicking in 
the listbox provided, or by using a corresponding hotkey combination (either Control-0 
through Control-9 or F1 through F12).

The Avatar window is divided into three parts, as shown in the following window. The 
scrolling list in the center of the window contains a slot for each Shortcut Key (these 
function as hotkey combinations for ultra-speedy changes). In addition, the list 
indicates which avatar slots are currently in use and which are available.
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• Browsing for Avatars. To view an avatar without wearing it, click on its slot in the 
Shortcut Key list. The Saved Avatar image on the right side of the window will 
instantly change to display the selected avatar. Selecting an empty (“available”) 
slot displays a default groggy-faced roundhead.

• Wearing an Avatar. To wear a selected avatar, click Wear This. The Current 
Appearance image on the left side of the window will instantly change to 
duplicate the selected avatar.

• Saving an Avatar. To save your current appearance in an avatar slot, select an 
available slot from the Shortcut Key list (or an in use slot that you want to 
overwrite), and click Save This. The Saved Avatar image on the right side of the 
window will instantly change to duplicate your current appearance.

NOTE – You can store more avatars by using the Shift and Control keys in combination 
with mouse clicks.

Talking to people

The primary activity on any Palace site is conversation between people. Therefore it is 
not surprising that The Palace software provides you with a number of ways to express 
yourself.
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The most commonly used form of speech is called talking. Talking is represented by 
"normal" text, appearing in a cartoon-balloon near the speaker’s head (or center-most 
prop). To talk, click on the Input Box at the bottom of your screen (you may first have 
to press the Tab key activate the Input Box), type something, and press Enter. Your text 
will appear in a cartoon-balloon near your head.

You can control the length of time text stays up on your screen by setting the Balloon 
Delay, which can be found under Preferences on the Edit Menu. From the Preferences 
window, you can also control the Font and Font Size used in all cartoon-balloons with 
the Change Font button.

Special balloons
The default state of your cartoon-balloons is the normal “talking” balloon, as can be 
seen by a quick look at the Toolbox, where this button normally appears in a “down” 
state. 

Of course, talking in a normal manner sometimes doesn’t get your point across quite 
the way you mean it. For these situations, the Toolbox provides you with several 
additional types of cartoon-balloons, including shouting balloons, thinking balloons 
and rectangular sign balloons.

There are two ways to change the type of balloon used to display a typed message. The 
easy way is to use the Toolbox, which includes a number of buttons dedicated to 
balloon control. The other way is to use special characters in front of your typed text.

The following table explains how to activate the various balloon types, and illustrates 
their effect on an example message (“my message”).

Balloon Type via Toolbox via Input Box

: my message
Want to give people a piece of your mind? This 
gives you a “thought” balloon instead of the 
normal “talking” balloon.

^ my message
This gives you a rectangular “sign” balloon that 
stays up until you move or say something else. 
Useful for saying things like “BRB” (Be Right 
Back).
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Whispering and ESP (private messages)
By clicking directly on another person’s avatar with your left mouse button, or 
selecting Whisper from their avatar menu, you enter Whisper Mode. All other avatars 
on the screen become slightly darker, and the phrase Talking to: name appears in the 
Status Bar (name indicates the name of the targeted user). At this point the person you 
have clicked on has no idea that they have been selected. To whisper to this person, 
simply type your message into the Input Box as usual. Both you and the other party 
will see your message appear on the screen in italics, but no one else will see the 
message. Subsequent messages continue to be private, until you de-select the person 
by clicking on the Status Bar or by selecting another person. You can also select Stop 
Whispering from that user's avatar pop-up menu (right-click on their avatar to display 
this menu).

The Palace software also allows you to whisper to people in distant rooms; this is 
called ESP. To do it, simply open the User List window (by selecting Find User from 
the Options menu) and click once on the name of the person you wish to speak to. 
Regardless of their location, they will see your message in italics (and no one else will). 

NOTE – Sounds and Special Balloons do not work in ESP Mode.

Keeping track of conversations with the log window
The Log window records a log of your session, including all conversations and actions 
by avatars in your room. The Log window displays by default; you can close it just like 
any other Windows dialog. To open it again, select Log Window from the Options 
menu, or click the Log button on the Toolbox.

! my message
This gives you an excited-looking “spiky” 
balloon. Useful for shouting.

@x,y my message
Allows you to “spoof” by placing your balloon 
wherever you want it (e.g., “*100,200 my 
message”). X cannot exceed 512. Y cannot exceed 
384. NOTE: The spoofing capability is disabled on 
many Palaces.

Balloon Type via Toolbox via Input Box
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Paging an operator
Operators are the authority figures of the Palace community; they tend to be either the 
owners of the site in question, or individuals who have been granted special powers 
and capabilities by the owners. In either case, a major concern for most operators is 
keeping the peace, and they possess an arsenal of commands allowing them to do just 
that. Operators are able to disconnect unruly users at will, or cause them to be banned 
from the site indefinitely. They can even ban whole domains if they decide it's 
necessary. In short, they're very powerful people.

Operators are also interested in making sure their site is viewed as a popular and 
hospitable place. For this reason many operators are happy to take a little time out of 
their day to explain the basics to a new user, or to help out with a tricky scripting task.

If an unruly user is harassing you, or even if you just want a hand with some aspect of 
the site you're visiting, the best thing to do is page the local operators. Use the 'page 

messagetext  command. For example:
'page Is there a website where I can get all the sounds for this Palace?

This statement, typed into the Input Box, will send your question to all operators 
currently logged on to the local Palace site.

NOTE – This command should be used sparingly, and only when you actually do need 
help of some kind.

Finding people

The Palace makes it easy to find out who else is in your Palace through the User List 
window. 

▼ To access the User List window
From the Options menu, select Find User. The User List window appears. 

• To send a private message, double click the user's name and type your message 
in the Input box. 

• To join the user in their room by selecting their avatar name and clicking Goto. 

The Rooms List window (described in the section Jumping to a specific room on page 35) 
also lists how many users are in each room in your Palace. You can join others in that 
room through this window.

You can also find out where users are if they have allowed that information to be 
displayed in their Profile page. Bring up that person’s profile page (see To see somebody 
else’s profile page on page 26) and click Join me! on their page.
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Playing sounds

The Palace has a built-in set of audio files that everyone can use. These files are located 
in your Sounds  folder (which is within the Media  folder). 

▼ To play sounds

1. Do one of the following:

Select Play a Sound from the Options menu.

Or
Click the Play Sound button in the toolbox.

Either of these display the Sounds window. 

2. In the Sounds window, play a sound by double-clicking on its name, or by 
selecting the sound and clicking Play. 

Or
Type a right parenthesis followed by the name of the sound:

)applause

You can even follow a sound with spoken text:

)applause She shoots! She scores!

The list of built-in sounds includes amen, applause, belch, boom, crunch, debut, fazein, 
guffaw, kiss, no, pop, teehee, and yes. 

In addition to these standard sounds, many Palace operators add their own sounds to 
their own Palace sites. By default, these sounds download into Sounds  folders beneath 
the Palaceroot \Media\ PalaceName  folders, although many of them are also available 
via the world wide web, and must be placed into the appropriate folder “by hand.” If 
you have some sounds you'd like to play no matter what Palace site you are accessing, 
simply move (or copy) them to your \ Palaceroot \Media\Sounds folder; any sound 
files placed here will always appear in the Sound List window, no matter which Palace 
site you are logged into. Remember, however, that only users who possess the same 
sounds themselves will be able to hear them when played.
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Moving around

There are several ways to move around in the Palace in a specific room:

• With your mouse, click on any spot in the room. Your avatar moves to that spot.

• Use the arrow keys to make small vertical and horizontal moves. If the Input Box 
is currently active, the arrow keys won't work this way; press the Tab key to toggle 
focus back to the View Screen. Also, be careful about abusing this feature. 
Continual arrow-key movement causes considerable and unnecessary strain on the 
Palace Server, and may get you kicked off many Palace sites. 

To move to other rooms or Palaces, use one of the following methods:

• Spots and doors

• Jumping to a specific room

• Joining another user

• Going forwards and backwards

Spots and doors
Although the various ways out of rooms are usually clearly marked, sometimes they 
are not. In a Palace site, any wall hanging or crystal ball might be a portal to another 
room. If your cursor changes to a hand while over an area, a door is present. When you 
click on a door, you are immediately transported through it (if it is open). Note that 
using the arrow keys to move onto a door does not activate the door. Doors go to 
rooms inside your current Palace.

To show door outlines, click the Show/Hide Door Outlines button in the Toolbox, or 
press Shift-Control.

Rooms can also have hot spots. You can click on these spots to go to other Palaces, 
send your web browser to a web site, or start a scripted event.

Jumping to a specific room
Another convenient way to move is to use the Goto Room command from the Options 
Menu (hotkey combination Control-G).   This opens the Room List window. Select and 
click the room you wish to go to. You can only enter rooms that are public and 
unlocked using this feature.

Joining another user
You can join another user in the same Palace by opening the User List window (select 
Find User from the Options menu), selecting the person's name, and clicking Goto. 
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Going forward and backwards
You can use the Go Back/Go Forward functions to return to rooms or Palaces you 
previously visited, and then return to your current one. There are several ways to do 
this:

• Click the back/forward arrow buttons on the toolbox. 

• Select Go Back or Go Forward from the Options menu.

• Press Control-B to go back, or Control-O to go forward.

Props

A prop is an object that can be worn near or placed over your face, a small graphic 
object that you can hold (like a baseball bat or a cup) or attach to yourself (like a hat, a 
pair of sunglasses or a wig).

Palace members are able to pick up any loose props they find lying around, no matter 
what Palace site they happen to be in. You can keep these props in your prop window. 
You can even create and edit your own customized props, so you can create a new look 
for your avatar. 

Your prop window
Props are often employed in combination; up to nine props may be worn on your 
avatar at one time. Props are put on, taken off, edited, saved and deleted through your 
prop window.

To access the prop window, do one of the following:

• Click the suitcase icon at the bottom right corner of your Palace client window.

• Press Control-P.

• Select Prop Window from the Options Menu. 

Once the prop window is open, you can double-click on any prop to put it on, and 
double-click on it again to take it off.

The Prop Pop-Up Menu
Right-clicking on a loose prop displays its pop-up menu. The options on this menu let 
you quickly and easily take, copy (same as take, but leaves a copy of the prop where 
you found it), wear or delete the prop in question.
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The prop pop-up menu

General prop actions
A loose prop is one that you find lying in a room, not attached to any avatar. You 
pickup, wear, and store these props in your prop window. You can also leave loose 
props for other people to use. The easiest way to create a “loose” prop is to put it on 
(by double-clicking on it in your Prop window), then pull it off your face, and drag it 
into the room.

There are several things you can do with loose props:

Creating and editing props with the prop editor
You can edit existing props, and create new ones using the prop editor. For detailed 
information on the prop editor interface, see the Prop editor subsection of the Palace 
Client Interface.

Action How to do it

Move prop Select the prop with your mouse cursor and drag it around. You 
will notice that you can't actually put a prop on somebody else; 
they have to pick it up and decide to wear it. Similarly, you can't 
grab a prop that somebody else is wearing; they must give it to you 
by dropping it (of course, it is possible to “grab” props by doing a 
screen capture...)

Put prop in 
prop window

Drag the prop to your prop window, or select it, bring up its prop 
menu, and select Take Prop.

Put on prop Either drag the prop onto your avatar, or select Take and Wear 
from its pop-up menu. Both these actions also add the prop to your 
prop window. You can also select Copy and Wear to take and 
wear only a copy of the prop (leaving the original behind).

Put copy of 
prop in your 
prop window

This takes only a copy of a loose prop (leaving the original behind). 
Either hold down the Control key while you drag the prop to your 
prop window, or select Copy Prop from its pop-up menu.

Delete prop Drag it to the Trash Can at the bottom right corner of the screen.
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Editing an existing prop

From your prop window, select the prop to edit and click Edit. (If you want to keep the 
original copy of the prop, make sure you duplicate it first by clicking Dupe.) The Prop 
Editor appears, displaying the selected prop. In the prop editor, you can color and 
change the look of the prop using the prop drawing tools. 

Creating a new prop

You can use the Prop Editor allows you to quickly and easily create new props by 
pasting in graphic images from any graphic viewer or editor. This is very similar to 
creating a new avatar image.

1. Open the original image using any quality graphic editor, and copy it.

2. In the Palace software, open your prop window and click New to open the Prop 
Editor.

3. Paste the image in the Prop Editor (Paste from the Edit Menu, or Control-V).

4. Save your new prop by clicking OK.

If the picture is up to 44 x 44 pixels (the size of a single prop), it will appear in full. If 
the image is larger, only the upper-left 44 x 44 pixels will be pasted into the area.

You can use the Edit:Paste Multiple Props menu item to handle images larger than 44x 
44. See Multiple-Prop Avatars on page 28 for more information.

Changing the position of your prop

While the prop editor is open, click on the Selector tool (the dotted square) to select 
your entire prop. The arrow keys on your keyboard may now be used to move the 
image around, relative to the central position of the roundhead. The total area allowed 
is equal to nine prop-sized squares, arranged in one big 3 by 3 square. Any prop may 
be saved while occupying any position in this large square, and the prop’s position will 
be saved as well.
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This section describes the general structure of the Palace User Interface:

• Elements of the main window on page 39

• The Menus on page 44

• Hotkey combinations on page 53

• The room drawing tools on page 54

• The prop editor on page 55

Elements of the main window

The Palace has the following main window:
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The Palace client interface

The View Screen
A large rectangular area known as the View Screen dominates the Palace interface. This 
is where all graphic action takes place. As you move from room to room within a 
Palace site, the View Screen is filled with a picture representing the background of that 
room. All avatars and props in the room appear superimposed on this background.

NOTE –  Room Graphics and Download Time. Most Palace sites use at least one or two 
pieces of original art. When you enter the corresponding rooms, these pictures will be 
automatically downloaded into the Pictures folders located inside your 
Palaceroot \Media\ PalaceName  folders.

If you already possess the graphics for the room you are entering (i.e., if you’ve been 
there before) this transition is completely transparent and takes almost no time at all. If 
you enter a room you’ve never seen before, however, you’ll have to wait for the room’s 

Status Input Box View 

Tool

Icons
ScreenBar

Box
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background image to download; a process which generally takes 15 to 60 seconds on a 
28.8k baud modem. While the image is downloading, the room’s background will be 
black and a progress bar will appear in the bottom part of the View Screen, indicating 
the status of the download. Props and avatars, being smaller in file size, will usually 
become visible before the room’s background pops into place.

The Toolbox
The Toolbox, which is accessed by selecting Toolbox from the Options Menu, provides 
simple shortcuts for many of the most commonly used commands.

Most of the Toolbox buttons duplicate menu commands. For example, clicking on the 
Connect to a Palace button is equivalent to selecting Connect to a Palace from the File 
Menu.

Connect to a Palace

Go Back

Go Forward

Talk Balloon

Shout Balloon

Sign Balloon

Thought Balloon

Log Window

Sounds Window

Face Window

Paint Window

Show Doors

Show Names
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The toolbox has the following buttons.

Button Description

Connect To A Palace
This button is used to enter a Palace site. Clicking here will cause a dialog 
box to appear asking for the address you wish to connect to. The last eight 
Palace addresses you have visited will appear as choices in the drop-down 
listbox. If the destination Palace Server is running on the same computer, 
you can connect directly by pressing the Shift key while you click on this 
button. See Connecting to Palace Sites on page 17 for more information.

Depending on your Dialup Networking settings, Windows may display the 
Connection Operator; press the Escape key or click Cancel to abort the 
dialup and connect directly to your own Palace.

Go Back
This button moves you back to the previously-visited room. If you have just 
entered a new Palace site, this button may be used to return to the previous 
Palace site as well (via the standard entrance — not the room you were last 
in). The hotkey combination for this command is Control-B.

Go Forward
This button returns you to the room you were in prior to doing a Go Back. 
Like the Go Back button, it may be used to jump to another Palace site. The 
hotkey combination for this command is Control-O.

Talk Balloon
This button causes your speech to be displayed in a normal “talking” 
balloon. 

Shout Balloon
This button causes your speech to be displayed in a spiky balloon, useful for 
"shouting." 

Sign Balloon
This button causes your speech to be displayed in a rectangular "sign" 
balloon, which remains on the screen until you say something else. 

Thought Balloon
This button causes your speech to be displayed in a cloud-like "thought" 
balloon. 

Log Window
This button opens and closes your Log Window, allowing you to read chat 
that has disappeared from the View Screen. The hotkey combination for this 
command is Control-L. Note that you can save the contents of your Log 
Window by selecting Log to File… from the File Menu. 

Sounds Window
This button toggles your Sound List window open and closed. The Sounds 
window lists all sounds in your Palaceroot\Media\Sounds folder, as 
well as those in Palaceroot\Media\PalaceName\Sounds.  This means 
that different sounds may be available on different Palace sites. You can play 
a sound by double-clicking on it or by selecting it and then clicking Play. 
The hotkey combination for this command is Control-Y. See Playing sounds 
on page 34 for more information.
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The Input Box
The long, thin box beneath the View Screen is known as the Input Box. This is where 
you type in anything you want to say (Palace members can enter Iptscrae commands 
from this box as well). To activate the Input Box, simply click anywhere in it; the box 
lights up and a cursor-bar appears, awaiting your input. You can toggle the program’s 
focus back and forth between the Input Box and the View Screen by pressing the Tab 
key.

The Status Bar
The area just between the Input Box and the View Screen is known as the Status Bar.   
The Status Bar typically displays the following information:

• The name of the current room

• The number of people in the current room / the number of people in the current 
Palace

• The name of the person you are talking to, if you are in Whisper Mode.

Under certain conditions the Status Bar will display error messages (when the 
connection is refused, for instance, or when the server goes down). The Status Bar may 
also be scripted (by the "operators" of a site) to display specific messages, greetings, 
marquees, and other text.

Face Window
This button opens and closes your Choose an Avatar window, where you 
can change your expression and face color. This window may be kept open 
while moving around in the Palace, so you can change your appearance 
almost instantly See Changing expression and color on page 23 for more 
information.

Paint Window
This button opens and closes the room drawing tools, which is a floating 
window containing a number of special tools for drawing directly on the 
screen. The hotkey combination for this command is Control-D. See The 
room drawing tools on page 54 for more information.

Show Doors
This button toggles all door outlines in the current room between visible 
and invisible states. You can do the same thing temporarily by 
simultaneously holding down the Control and Shift keys. 

Show Names
This button toggles all nametags in the current room between visible and 
invisible (a nametag is a small label attached to a person’s avatar, indicating 
their user name). You can do the same thing temporarily by simultaneously 
holding down the Alt and Control keys.

Button Description
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The Icons
To the right of the Input Box are two icons: a suitcase and a trash can. These icons are 
used to activate features that operate independently of the windows.

The Menus

This section describes the functions of all menu commands in the Palace interface.

The File Menu
The File Menu contains commands for entering and leaving the Palace. In addition it 
contains file-oriented commands, such as logging your conversations and saving your 
avatars.

Connect to a Palace

Use this option to bring up the Palace connect window, which you can use to sign on 
to a Palace site.

Disconnect

This command disconnects you from the current Palace site without exiting the 
program.

Save Avatar

This command opens the Avatar window, allowing you to save your current avatar (or 
wear a different one). 

Open Log File  |  Close Log File

This command toggles your log file open and closed. A log file records all chat text and 
commands received to a file on your hard disk. Note that this is not the same thing as 
your Log Window, which disappears as soon as you exit the Palace software.

The Suitcase
Clicking on this icon opens the Prop window, giving you access to 
your current collection of props. This lets you add, edit, create, and 
remove props from your prop window.

The Trash Can
Use this icon to delete props. To delete a prop, drag it to the 
trashcan.
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Compress Prop File

As you travel from Palace to Palace, your prop file (palace.prp ) acts as a “cache,” 
storing copies of new props encountered along the way and speeding the display 
process for already-seen props. This causes the file to grow as you proceed. The Palace 
software automatically compresses the prop file once every two weeks, but if you’re a 
serious Palace-hopper you may want to do this more often.

Child Lock

This command brings up a dialog box that allows you to set a password for using your 
Palace software. Do not forget this password — once you've set it, you will be asked to 
supply it every time you launch the Palace software.

Reload Script

This command reloads your cyborg.ipt file — the only Palace datafile you can edit 
while online. You can edit your cyborg.ipt file at any time with any ASCII word 
processor (running in another window), save it and return to The Palace software, but 
your changes will not become effective until you select Reload Script.

Enter Registration Code

This command allows you to enter in your unique membership key, giving you access 
to the members-only features of the Palace software. Note that membership is free. You 
obtain your registration code online at the Palace website (www.thepalace.com ).

Exit

This command disconnects you from the current Palace site and exits the Palace 
software.

The Edit Menu
The Edit Menu contains the standard Windows-based editing commands, as well as 
the important Preferences window.

Cut

This command allows you to cut text from the Input Box. It can also be used for 
graphic functions, such as when working in the prop editor. The hotkey combination 
for this command is Control-X.

Copy

This command allows you to copy text from the Input Box or the Log Window. It can 
also be used for graphic functions, such as when working in the prop editor. The 
hotkey combination for this command is Control-C.

Paste

This command allows you to paste text into the Input Box. It can also be used for 
graphic functions, such as when working in the Prop Editor. The hotkey combination 
for this command is Control-V.
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Paste Multiple Props

This command allows you to paste oversized graphics into the Prop window, where 
they are divided into individual props. The maximum size graphic that can be handled 
is 132 by 132 pixels.

Clear Log

This command clears the current contents of the Log Window. The Log File (if you are 
keeping one) is not affected.

Edit Profile Page

This launches your web browser and takes you to your Profile settings page. Here, you 
can update the settings on your user profile. See Profile pages on page 26 for more 
information.

Preferences

This brings up a dialog box allowing you to set the following options:

The Preferences window

The Preferences window has the following fields.

• User Name

This is the name that others will see attached to your avatar.
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• Autoshow Names

Toggles the display of user names in the View Screen. You can make these names 
appear temporarily by holding down the Alt and Control keys. You can also toggle 
this option by clicking on the Show Names button in the Toolbox.

• Download Graphics

Instructs the Palace to request images for new rooms you enter. If this option is 
unchecked, new rooms will appear black in your View Screen.

• Show Tooltips

Determines whether or not Tooltips are displayed when the mouse pauses over a 
button in the Toolbox.

• Tinted Balloons

When checked, this option causes all cartoon balloons to appear filled with color 
(by default they are white).

• Allow Animation

This option allows you to view “animated props” (multiple-frame sequences of 
props which create the illusion of motion or action). If not checked, only the first 
frame of any animated prop sequence will be seen.

• Show Guests in User List

This option determines whether the User List will display the names of all users 
(both guests and members), or the names of members only.

• Change Font

Clicking on this button displays a standard Windows "font dialog box", allowing 
you to set the font (including typeface, size and style) used to display all Palace-
based text (including all cartoon balloons, user names and hotspot names).

• Balloon Delay

Modifies the base length of time that cartoon balloons will be displayed. Three 
durations are available (Slow, Medium and Fast). Note that the duration of any 
message is based upon the length of the message itself, modified locally by this 
setting.

• Palace Starts With

All Palace addresses have two parts: a URL (domain name or numeric IP) and a 
port number. The two input boxes in this area allow you to enter this information 
so that you can connect to the specified Palace site. This area also includes some 
shortcuts to help make connecting even easier. The dropdown list on the left recalls 
the names of the last eight Palace sites you’ve visited; these can be selecting simply 
by clicking on them and then clicking Ok. You can also set a “Home Palace” which 
will be entered automatically whenever you launch the Palace software (just like a 
“Home Page” in your web browser). To do this, check the Home Palace field and 
type in the address and port number desired.
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NOTE – Note that the port number (to the right of the server address proper) is set by 
the operators of the site in question: it is almost always “9998.” If you cannot get into a 
known Palace site, contact the operators and make sure you’re pointed at the correct 
port number.

The Options Menu
The Options Menu contains various commands for controlling the behavior of the 
software, as well as several means of transportation throughout Palace sites.

Show Names

This command, like the Show Names button in the Toolbox, toggles the display of user 
names in the View Screen. To make user names appear temporarily, hold down the Alt 
and Control keys.

Sound On/Off

This command toggles all sound on and off. The hotkey combination for this command 
is Control-S.

Play A Sound

This command opens your Sounds window. The hotkey combination for this command 
is Control-Y. You can also display or hide the Sound window by clicking on the Sound 
Window button in the Toolbox.

Full Screen

This command toggles between a maximized display and a windowed display.

Go Back

This command moves you back to the previous room visited. You can do the same 
thing by clicking on the Go Back button in the Toolbox. The hotkey combination for 
this command is Control-B.

Go Forward

This command functions identically to the Go Forward button in the Toolbox, 
returning you to the room you were in prior to doing a “Go Back,” The hotkey 
combination for this command is Control-O.

Find User...

Select this option to open/close the User List window. The User List displays a list of 
all people logged into the current Palace site, and the names of the rooms they are in.
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User List (Operator Mode)

Clicking on a user’s name in this window causes you to enter ESP Mode with that 
person: you may now speak to them just as though you were whispering, no matter 
where you both are in the Palace.

Clicking on the User column sorts the list alphabetically by user name. Clicking on the 
Location column sorts the list by room name.

To instantly teleport yourself to another avatar's location, double-click on its name, or 
select its name and then click Goto. Exception: rooms marked “Private” cannot be 
entered (except by operators and owners).

Note that the operator mode adds an additional Kill button.

The hotkey combination for this command is Control-F.

GoTo Site Page...

This launches your web browser and takes you to the site page of the Palace you are 
currently visiting.

Goto Room...

Select this option to open/close the Room List window. The Room List displays a list 
of all rooms in the current Palace site, and the number of users in each room 
(regardless of their membership status).
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Room List

When opened, this list displays all non-hidden rooms in their “natural” order (that is, 
the order in which they appear in the server’s Pserver.dat  file). Operators and 
owners will see all rooms, hidden or otherwise.

Clicking on the Room column sorts the list alphabetically by room name. Clicking on 
the Users column sorts the list by number of users. To return the Room List to its 
initial order, close it and open it again.

To instantly teleport yourself to another room, double-click on its name. Exception: 
rooms marked “Private” cannot be entered (except by operators and owners).

The hotkey combination for this command is Control-G.

Toolbox

This command opens and closes the Toolbox. The hotkey combination for this 
command is Control-T. For more information, see earlier in this guide.

Show Tooltips

This command toggles the display of tooltips when holding the mouse over a button in 
the Toolbox.

Draw

This command opens and closes the room drawing tools window. You can do the same 
thing by clicking on the Draw window button in the Toolbox. The hotkey combination 
for this command is Control-D. See the following section on the Room drawing tools for 
more information.

Log Window

This command toggles your Log Window open and closed.    You can do the same 
thing by clicking on the Log Window button in the Toolbox.
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Prop Window

This command brings up your Prop window. The hotkey combination for this 
command is Control-P. You can do the same thing by clicking on the suitcase icon at 
the bottom right of your window. 

Operator Mode

This command opens a dialog box asking for the operator (or owner) password. 
Operators and owners have special powers and capabilities beyond those of registered 
members; there are different operators and owners (and passwords!) at each Palace 
site. If the password is entered correctly, the Operator menu is added to your menu 
bar. The hotkey combination for this command is Control-W.

The Bookmarks Menu
Use the options in the Bookmarks Menu to travel quickly and easily from Palace to 
Palace. 

Add Palace to Bookmark

This command adds the current Palace address to the list in your Bookmarks window. 
Whenever a new bookmark is added, the Palace name appears beneath the separator 
bar at the bottom of this menu, enabling you to travel there with a click of the mouse.

Edit Bookmarks...

This option displays the Bookmarks window. The Bookmarks window lets you  select 
a Palace site to travel to without requiring you to disconnect or remember the URL. To 
travel to any Palace on the list, simply double-click on its name, or select the Palace 
desired and click Goto. To remove a Palace site from the list, select it and click Delete. 
To close the Bookmarks window, click either Close or on the small box in the upper 
left corner of the window.

Channel Guide

This option brings up the Palace Channels Guide web page, which lets you access the 
latest and most exciting Palaces. 

Palace Directory

This command automatically launches your web browser and takes you to the Palace 
Site Directory on the Palace website. 

List of Palaces

The Bookmarks menu lists Palaces owned by Communities.com, and all of your 
recently-visited and bookmarked Palaces. Select one of these to go to that Palace.
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The Avatars Menu
Guest Avatars...

Select this option to bring up the Choose an Avatar window. See Changing expression 
and color on page 23 for more information.

Member Avatars...

Select this option to bring up the Avatars window. See Saving and wearing your new 
avatar on page 29 for more information.

Change Avatar Name...

Select this option to change your avatar name.

The Operator Menu
This menu appears when you enter operator or owner mode (select Operator Mode 
from the Options menu, then enter the operator or owner password). The Operator 
Menu provides access to a set of advanced functions beyond the needs and rights of 
typical Palace members. Operators and owners are the “managers” and “proprietors” 
of the various sites in the Palace network. Anyone with a Palace Server or Palace 
Personal Server (and an IP address) can open a Palace site and become its owner, and 
then give the site’s operator password out to trusted individuals. Therefore, each 
Palace site has at least one owner, and most possess operators as well.

NOTE – The Operator Menu appears on your menu bar only if you are currently an 
operator or owner on the Palace site in question. To access this menu, select Operator 
Mode from the Options menu, and then enter the operator/owner password in the 
resulting dialog window.

The commands in this menu provide operators (or owners) with various 
“superpowers” in the form of special commands and authorial control over their 
Palace sites. Since proper utilization of these commands requires an in-depth 
understanding of the Server software, this topic is not treated here. For information on 
operator commands and the operator menu, see The Palace Operator's Guide.

The Plugins Menu
The Plugins Menu includes an entry for each of your Palace Plugins — small 
programs that enhance the functionality of the Palace software.

To appear in this menu, your Plugins must be installed in the 
\ Palace root folder \Plugins folder. This is where they are installed by default. 
However, if you wish, you can place them in \Plugins\Startup ; this will cause them 
to launch automatically when you start the Palace software, instead of waiting for you 
to select them from the Plugins Menu.
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The Help Menu
The Help Menu consists of a number of links that, when clicked, will take you to the 
appropriate page at The Palace website. The topics covered include:

Quick Reference

User Guide

FAQ

Software Update

Discussion Groups

Communities.com

About the Palace

Hotkey combinations

The following hotkey combinations are available to users:

Key Description

Tab key Toggles focus between the Input Box and the View Screen. 

Up Arrow 
key

When the focus is on the Input Box, this pages back through your 
previously typed statements. When the focus is on the View Screen, 
the arrow keys allow you to move your avatar around on the 
screen.

Down 
Arrow key

When the focus is on the Input Box, this pages forward through 
your previously typed statements. When the focus is on the View 
Screen, the arrow keys allow you to move your avatar around on 
the screen.

Esq. key Clears the Input Box. 

Alt and 
Control 
keys

If the Autoshow Names option is unchecked (in the Preferences 
Dialog Box), this hotkey combination temporarily displays the 
names of all people in the current room. If Autoshow Names is 
checked, this combination causes the names to temporarily 
disappear.

Control 
and Shift 
keys

When held down simultaneously, these keys cause the outlines of 
all doors in the current room to become visible.
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The room drawing tools

The Palace client provides room drawing tools, where you can paint and draw in the 
room you are currently visiting. Both the room and the Palace site must have Painting 
privileges set on for you to do this. To access the drawing tools, click the Palette icon 
on your Toolbox, or select Draw from the Options menu.

The room drawing tools

Everybody in the room sees whatever is painted. However, operators and owners can 
turn painting off in particular rooms, or on a site-wide basis. Some Palace operators 
consider painting to be a “nuisance” activity, and prefer to turn it off completely.

Pencil/Filled Region

Line Sizer

Detonator

Layer

Palette
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The prop editor

The prop editor lets you create and edit images for props and avatars. Like the room 
drawing tools, it has a set of drawing tools and a color palette. To access the prop 
editor, open your prop window (click the suitcase icon at the bottom right of your 
screen), and click New. Or, select an existing prop on your prop window, and click 
Edit.

The following picture shows the prop editor tools:

Tool Description

Pencil | Filled region This tools lets you draw in various colors and line sizes. It has 
two states: Pencil and Filled Region. The Pencil tool is active 
when no colored area appears around the pencil. The Filled 
Region tool (activated when a colored area does appear around 
the pencil operates similarly, but turns the region drawn into a 
closed shape.

Detonator When you click this button, it deletes the last line that was 
drawn, whether it was created by hand or by a script. Double-
click this button to delete all drawing on this screen.

Layerer You can draw either behind or in front of avatars. Click this 
button to toggle the pen between these two layers.

Line Sizer This button changes the width of the Pencil and Filled Region 
tools. The center diagonal line is the current width. To increase 
the line size, click the line in the upper right corner. To 
decrease the width, click the line in the lower left corner.

Palette The Palette tool lets you select a drawing color from the Palace 
palette.

Eyedropper Although not visible as a tool, there is an eyedropper tool 
available for selecting colors directly off the screen image. The 
cursor changes to an eyedropper when you press both Control 
and the mouse button simultaneously anywhere in the View 
screen, no matter which tool is selected. The color that the 
cursor is pointing to becomes the current drawing color. This is 
useful for extending a particular color you see on the screen.
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Some of these tools have special functions, or respond differently when certain key 
combinations are pressed. The following table describes the prop editor's tools.

Tool Description

The Pencil 
Tool

Use this tool for drawing or editing details. To constrain the pencil 
to a straight line, hold down the Shift key while drawing. To turn 
the pencil into a paint bucket, hold down the Alt key. To turn the 
pencil into an eyedropper for picking up colors, hold down the 
Control key.

The Eraser 
Tool

Use this tool to create transparent areas. Note that erased portions 
are transparent; they allow whatever is behind them to show 
through. To “pour transparency” into solid-colored areas of your 
prop, hold down the Alt key.

The 
Selector 
Tool

Use this tool to move or delete sections. Click and hold down the 
mouse button down at one corner of the desired area, drag to the 
opposite corner (with the mouse button still depressed), and 
release. The selected area may now be moved around, or removed 
with the Delete key.

The Line 
Sizer Tool

Use this tool to change the pencil and eraser size. The diagonal line 
in the center of this button indicates the current size of the pencil 
and eraser. To increase the line size, click in the upper-right corner 
of the button. To decrease it, click in the lower-left.

The Pencil Tool

The Selector Tool

The Eraser Tool

The Palette

The Line Sizer Tool
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In addition, the prop editor has the following fields:

• Head

Check this box to completely replace your head with the prop. A head prop is a 
prop that completely replaces your face. Any prop may be made into a head prop. 

• Ghost

Check this box to make the prop a ghost prop. A ghost is a semi-transparent prop: 
other props and background art can be seen faintly through it. Any prop may be 
made into a ghost prop.

• Rare

Check this box to create a prop that cannot be copied. Unlike normal props, rare 
props disappear from the satchel when they are donned. In other words, only ONE 
such prop can exist.

• Anim

Check this box to make your prop into a single frame for animation. An animated 
prop is like a frame in a small movie: when worn, it rapidly flashes on and off. If 
more than one animated prop is worn, they will flash in sequence, creating the 
illusion of animation. The following Bounce setting can modify the order of the 
sequence. To see animated props in action, select Preferences from the Edit Menu 
and check Allow Animation.

• Bounce

If this option is checked for any prop you are wearing, your animated props will 
cycle on and off in “palindrome” fashion (“forward-backward-forward” etc.), 
instead of simply looping in the “forward” direction all the time.

• Cancel

Closes the Prop Editor without saving any changes you have made.

• OK

Saves your work and closes the Prop Editor.

The Palette Select the color you want activate; that is, the one the pencil will 
draw with.

Prop Name Enter a name for the prop if desired. You can then use this name in 
scripts. For Palace members the prop's name may be especially 
important, since there are Iptscrae commands that can be used to 
manipulate props as long as their names are known.

Tool Description
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6 The PalacePresents 
Viewer

This section describes the PalacePresents Viewer and has the following sections:

• What is PalacePresents? on page 59

• Launching the PalacePresents Viewer on page 60

• What you need on page 60

• Setting preferences on page 61

• Joining an event on page 62

• The PalacePresents interface on page 63

What is PalacePresents?

This Palace Plugin allows you to take part in large-scale networked events such as 
conferences, guided web tours, slideshows, live interviews, lectures and other “one-to-
many” interactions. 

The PalacePresents software creates a multipurpose “stage” which is hosted on an 
existing Palace site. This stage appears in a separate window from the Palace software. 
The interesting thing about this stage is that once you’re connected to it, you can 
always see it — no matter what room you move to in the host Palace.

The PalacePresents software consists of two Plugins: a Moderator Plugin (which is 
used by Palace operators to set up and moderate events), and a Viewer Plugin (which 
you use to participate in the event while it’s “on the air”). The PalacePresents Viewer 
allows you to view all events transpiring on the stage, and to ask questions of the 
moderator and others on the stage. You can also keep a log of the event, and may even 
be invited onto the stage yourself!
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What you need

To participate in events via the PalacePresents Viewer, you must be running the Palace 
software for Windows 95/NT (version 3.0 or newer). You must also be a Palace 
member to participate in an event. Note that membership is free.

The PalacePresents Viewer Plugin is installed automatically by the Palace software. 
The name of the Viewer Plugin file is PalacePresents Viewer.dll . By default this 
file is installed into your \ Palacedirectory \Plugins\Startup folder, which causes it 
to load automatically whenever you start the Palace software. If you would prefer to 
load the Viewer manually (each time you use it), you can move it to the 

\ Palacedirectory \Plugins folder instead. Note that the file must be located in one 
of these two places to operate correctly.

Launching the PalacePresents Viewer

The following steps will get you started with the PalacePresents Viewer:

1. From the Plugins menu, select PalacePresents Viewer.

2. The PalacePresents submenu displays. If the PalacePresents Viewer has not 
already been loaded, the only entry on the submenu is Load. Click this to load the 
plugin. This toggles to Unload once the plugin is loaded.

3. Your PalacePresents Viewer is now loaded and active. Whenever you launch the 
Viewer while an event is running, or if an event goes “on the air” while you are 
running the Viewer, the Event Notification Dialog Box will appear, as shown in the 
following picture. Note that you will only be notified of events transpiring on the 
current Palace site.

Click Yes to participate in the event. The next thing you’ll see is the interface of the 
PalacePresents Viewer itself, which is described in the section Joining an event on page 
62.
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Setting preferences

Select Preferences from the PalacePresents submenu to display the PalacePresents 
Viewer Preferences window, where you can customize your PalacePresents.

• Show the Transcript in the Palace Log

When this option is checked, the transcript of the PalacePresents event will be 
merged with the Palace log, so that you can follow everything at once.

• Always Accept Stage Invitations Without Prompting

If this option is checked, you will be automatically transported to the stage 
whenever you are invited. Leave this option unchecked if you want to change your 
avatar or throw on a few props before you hit the stage.

• Prompt to Save the Transcript on Exit

If you exit the PalacePresents Viewer, or if the moderator ends the current event 
while you have this option checked, you will be shown a dialog box asking if you 
want to save the event transcript to a file. If this option is unchecked and either of 
these events occurs, the dialog box will not appear, and the event transcript will 
not be saved.

• Show System Messages in the Transcript

When this option is checked, additional system information messages are 
displayed in the transcript.
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• Show Slide Show URLs in the Viewer Window

The PalacePresents Moderator has the ability to run a “slide show” of web pages 
while the event is running. If this option is checked, all web pages visited will be 
displayed in the Browser Frame of your PalacePresents Viewer (beneath the 
Transcript window). If unchecked, your web browser will be launched separately 
to view these pages.

NOTE – To view the Slide Show within the Viewer window, you must have Microsoft’s 
“Internet Explorer” installed on your system (it does not need to be your default 
browser, however). If you don’t have Internet Explorer, you should leave this option 
unchecked.

• Always display the Viewer on Top

This option causes the Viewer window to cover all other windows you might 
currently have open (including the Palace window itself), and to remain that way 
until turned off.

• Remember Viewer Window Position across Events

When checked, this option will cause the height, width, and screen position of the 
Viewer Window to be stored upon closing the PalacePresents Viewer. The next time 
you enter an event (regardless of its location in the Palace Community), the Viewer 
window will appear at the same size and position as before.

• Name of the "Gone to Stage" Prop

While you are on the stage, a copy of your avatar remains in the Palace room from 
which you came (i.e. in the host Palace), but a special prop is added to it to indicate 
that you are onstage. If you want to supply your own “on stage” prop, simply type 
its name into this textbox; otherwise a default prop is provided for you.

• Default Button

Click this button to set all preferences back to their original default values.

Joining an event

If you launch the PalacePresents Viewer while an event is running (or, conversely, if an 
event goes “on the air” while your Viewer is running), you will only be notified of the 
event and given a chance to join the audience automatically. However, if you decline 
the initial invitation notice and then change your mind later, you can still get in.

Selecting Join an Event from the PalacePresents plugin submenu displays the Select 
Event to Join window. 
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Here you can select which event you want to join, and browse any web pages 
associated with the event. The first column of this list displays the names of all 
PalacePresents events currently running at the Palace Server you’re on. You can join an 
event in progress simply by double-clicking on its name in this list. Other features of 
this dialog box include:

• The Event Name field lists the name of the events.

• The Event Information URL area show the URLs of any web pages associated with 
the event. This gives you easy access to any prepared information on the event, 
topic, or presenter.

• To join an event, select it, and either double-click it, or click Join.

• Click Event Info to send your web browser to the page specified under Event 
Information URL.

• Click Private Event to access a private event. The PalacePresents Moderator has the 
ability to run Private Events that are not publicly advertised. These events may be 
password-protected, and are run on an “invitation-only”. If you have been invited 
to such an event, click on this button to access the Join a Private Event window, 
which asks you to enter the name of the Palace user hosting the event, as well as 
any password that has been provided for you.

The PalacePresents interface

The PalacePresents Viewer is easy to operate. It contains a few basic elements, 
including the Stage, the Textbox, three viewing Frames and a special Toolbar.
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As indicated in the illustration above, the PalacePresents Viewer allows you to see the 
avatars of anyone currently onstage. This includes the event presenter (or presenters, if 
there is more than one), as well as anyone else who has accepted the moderator's 
invitation to come onstage. Note that the moderator does not directly appear onstage. 
Moderator speech appears in a standard cartoon balloon in the upper-left corner of the 
stage area.

Invite Me

Off Stage

Preferences

View Event Info

Save Transcript

Info Frame
This frame
displays the
current event's
information
page (on the
web).  NOTE:
This feature
requires
Internet
Explorer.

Browser Frame
This frame displays
any "Slideshow" pages
created for the event.
PalacePresents
Slideshows are like
"guided web tours"
controlled by the event
moderators. NOTE:
This feature requires
Internet Explorer.

System Menu
Click on this small icon to bring up the Viewer’s System Menu, allowing you to browse
event information via the world wide web, and to save transcripts of your favorite
events.  These functions are also accessible using the toolbox to the left.

PalacePresents Stage
This is where the
presenters appear and
speak.  It works just
like a miniature
Palace window.

Textbox
While you're offstage,
the label here reads
"Submit Question.”
Typing  in a message
at this time (and
pressing the Enter
key) causes your
message to be
submitted to the
moderator.  While
you're onstage,
however, the label
reads "Chat,"  and
whatever you type
here goes out to the
entire audience.

Transcript
Window
This frame logs
all conversation
occurring
onstage.  You
can save it to a
file by clicking
on the Save
Transcript
button.
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Avatars can move around on the stage just as they can in a Palace room, and everyone 
who is connected to the event will see them moving. While onstage, you can wear 
props, even animated props, but you cannot change your avatar without leaving the 
stage again.

NOTE –  While you are onstage you also remain in the Palace room you were invited 
from, and a special “on stage” prop is automatically added to your avatar there. While 
onstage, you can continue to chat and move around in the Palace proper, and can also 
“broadcast” by typing into the viewer. You really can be in two places at once!

Talking to the stage
Whenever you're not on the stage (and that’s most of the time, for most of us), the label 
above the Viewer's Input Box reads Submit Question. Type your question, and submit 
it to the moderator by pressing the Enter key. If selected by the moderator, your 
question will appear onstage, just as you typed it. Note that the moderator not only 
has control of which comments are selected, but can also delay or shuffle comments, 
and may even preload a series of “simulated” comments prior to (or during) the event.

NOTE –  To submit questions to the moderator, you must be a Palace member. Guests 
can view the PalacePresents stage and read the flow of chat taking place there, but they 
cannot participate in the event directly.

The viewer’s input box allows you to use special balloons just as you can in the Palace 
client itself. See the section for more information.

The Viewer Toolbox
To the left of the stage you will notice a column of five buttons. These buttons comprise 
the Viewer Toolbox, which provides shortcuts for the most commonly-used functions. 
This section describes these buttons and their use.

Invite Me 

While you are watching an event (i.e. not onstage), clicking on this button means 
“Invite Me” (while you are onstage this button is disabled). Clicking here sends a 
message to the moderator, requesting an invitation to the stage. Note that if you have 
Always Accept Stage Invitations Without Prompting checked in the Preferences 
dialog box; you will be pulled onstage as soon as your request is accepted. Otherwise, 
you will see the following dialog box, which serves as your official invitation:
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Off Stage Button

While you are on the stage, the “Offstage” button becomes enabled. Clicking here 
causes you to leave the stage. A prompt will appear to make sure you really intended 
to make your exit.

Preferences Button

This button displays your PalacePresents Preferences window; it is the same as 
selecting Preferences from the PalacePresents plugin submenu.

View Event Info Button

This button launches your web browser, taking you to the Event Information web page 
that has been set up by the moderator. It is the same as selecting View Event Info from 
the System Menu. Note that if Show Slide Show URLs in the Viewer window is 
selected (under Preferences), all web pages visited will be displayed in the Browser 
Frame (beneath the Transcript window). If unchecked, your web browser will be 
launched separately to view these pages.

NOTE – To view the Slide Show within the Viewer window, you must have Microsoft’s 
“Internet Explorer” installed on your system (it does not need to be your default 
browser, however). If you don’t have Internet Explorer, you should leave this option 
unchecked.

Save Transcript Button

This button causes an ASCII transcript file to be saved on your hard disk. It is the same 
as selecting Save Transcript from the System Menu.

The System Menu
 You can access a number of special PalacePresents features and settings through the 
PalacePresents System Menu. To access this menu, click the system menu icon in the 
upper-left corner of the Viewer.
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Most of the items on the System Menu are standard, and will be familiar to all 
Windows users: Restore, Move, Size, Minimize, Maximize, and Close. There are also 
a few items that are specific to PalacePresents:

Preferences...

Select this option to display the PalacePresents Preferences Dialog; it is the same as 
selecting Preferences from the PalacePresents plugin submenu, or clicking on the 
Preferences Button in the Toolbox.

Join an Event...

This menu command displays the Event List.

Info About Current Event

This menu command launches your web browser, taking you to the Event Info page 
specified by the event moderator. This is functionally identical to selecting the View 
Event Info button in the Toolbox.

Save Transcript

Select this option to save a transcript of the event to a text file on your hard disk. By 
default, this file is named MM-DD-YY.LOG, although you can change the name and path 
to whatever you want. This is functionally identical to selecting the Save Transcript 
button in the Toolbox.
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This section describes advanced features you can use to enhance your Palace 
experience even further:

• Standard user commands on page 69

• Creating and maintaining your own room on page 69

• Automating yourself with Iptscrae on page 72

Standard user commands

The Palace software possesses a number of special commands allowing you to 
personalize your experience online. All special commands consist of text typed into the 
Input Box, and most of them begin with a single quote (' ). 

Although the special commands available may vary from site to site, you can see the 
standard list in the section Palace Command Summary on page 81.

Creating and maintaining your own room

Sometimes, you will visit a Palace site where the operator lets you create your own 
room. These member rooms exist only temporarily, deleting themselves whenever (A) 
there is no one inside and (B) when their owners disconnect from the current server. 
There are number of special commands associated with member rooms. Like most 
special commands, these are typed directly into the Input Box, and begin with a single 
quote (').

Member rooms have the following guidelines:
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• A member room will disappear from the Palace site if it empties out while its 
owner is logged off.

• If the room remains occupied, its owner may log off and log back on, and will 
retain ownership of the room.

• Member rooms all disappear when the server goes down.

• Normally, each member is allowed to create one (and only one) member room at a 
time.

'newroom roomName

Creates a new room with a cloudy sky background. If you don't supply roomName, 
the new room will be called "Jim’s room" (or whatever your name is). When you 
create a room you become its owner (similar to being a "channel op" on IRC), and 
may use all of the special commands listed below within that room. If the room 
empties out and you log off, the room will disappear.

'rdelete

Deletes the room. This command is rarely necessary, as the room will disappear of 
its own accord anyway.

'rowner userName

Allows you to transfer ownership of the room to userName .

'rname roomName

Renames the room to roomName.

'rpicture filename

Allows you to specify a new background picture for the room. You may use any of 
the default Palace pictures, (the bar, the study and the beach are the most popular — 
look in your Pictures folder to see the list). You can use a custom picture of your 
own creation if you wish, but only people who have a copy of that graphic will be 
able to see it; everyone else will see a black background.

'rkick userName

Kicks userName  out of the room. The person will be kept out for the remainder of 
their session, or until ownership is transferred. 

NOTE – They can get around this by logging off. If you are having a real security 
problem you can either use a password, close the room entirely with the rclose  
command, or page a operator for assistance.

'runkick userName

Cancels the effects of an 'rkick command.
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'rpassword yourPassword

Denies entrance to the room except to those who know yourPassword . When 
someone tries to get in, the server will deny access and request that the person 
type 'password yourPassword  to get in. For example, if you create a room and 
type:

'rpassword mojo

Other users will be unable to enter your room unless they type:

'password mojo

'rclose

Closes (locks) the room, preventing access by anybody except the room owner. If 
everybody inside leaves, the room automatically opens.

'ropen

Opens (unlocks) the room.

'rscripts on

'rscripts off

Determines whether or not user scripts can run within the room. Scripts are on by 
default.   

'rpainting on

'rpainting off

Turns painting on and off within the room. Painting (otherwise known as drawing) 
is on by default. The owner can do some painting (to make a sign) and then turn 
painting off to make a temporarily-permanent sign.

'rguests on

'rguests off

Denies access to guests (non-members).

'rhide on

'rhide off

Removes the room from the Room List (for all except operators and owners, who 
can still see it).

'runhide

Cancels the effects of an 'rhide command. Same as 'rhide off .
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Automating yourself with Iptscrae

As if you didn’t already have enough to keep you happily Palace-hopping for a long 
time, there are many more options available to you once you begin to master the 
intricacies of Iptscrae, the Palace programming language. Your initial introduction to 
Iptscrae will most likely be in the form of your own cyborg.ipt file (or “Cyborg 
Script”), that contains the routines used to automate aspects of your avatar ’s behavior 
online. This section provides a cursory overview of the contents of the cyborg.ipt 

file, and explains the operation of this file in its default state. For more information on 
Iptscrae, see the Iptscrae Language Guide.

NOTE – Modifying the cyborg.ipt  file requires a degree of familiarity with Iptscrae 
that is beyond the scope of this guide. Since the same commands and syntax are used 
to create Palace Server Scripts and Cyborg Scripts alike, would-be authors will want to 
read the Iptscrae Language Guide.

Your cyborg.ipt file
This section describes your Cyborg.ipt file, examining its structure and operation 
line-by-line. To make any changes desired, you'll need to open this file with a text 
editor or word processor capable of saving in ASCII ("text only") format. Always 
remember to make a backup copy before editing your cyborg.ipt file.

The cyborg.ipt file is a script, written in Iptscrae. Scripts contain handlers, which 
respond to events. These handlers are themselves contain short programs called 
atomlists. An atomlist could also be called a subroutine. To get a clearer understanding 
of what this means, let’s take a look at your default cyborg.ipt file.

The INCHAT handler

The first block of statements in your file is your INCHAT handler (as indicated by the 
words ON INCHAT and the open curly bracket in the first line):

ON INCHAT 

{

; expressive prop changes - in response to what others say

{ "Lightbulb" DONPROP { DOFFPROP } 120 ALARMEXEC } CHATSTR "you 
genius" == IF

...

INCHAT is where you store atomlists that respond to words you hear others say; 
atomlists in this handler are triggered by any CHAT event. You’ll notice lots of curly 
brackets throughout the script. These curly brackets indicate additional atomlists. 
Subject to syntax requirements, atomlists can contain other atomlists, but each must be 
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opened and closed with the corresponding curly bracket. You can tell when a script has 
reached its end by counting and pairing the open curly brackets with the closed ones. 
You’ll notice that the first open-curly bracket above has no partner. More on that soon...

The line starting with a semicolon (;) is a comment. The software ignores everything on 
the line after the semicolon. Commenting your code is good programming practice, 
and it will save you a lot of time when you come back to this file several months after 
editing it.

The functional stuff is contained in the IF  statement that follows the comment. This 
statement causes your avatar to don a lightbulb prop for 120 ticks (a tick is about 1/
60th of a second, so this is about 2 seconds) and then remove it, provided someone 
says the trigger phrase appearing in quotes ("you genius" ).

This sample lends itself to fairly easy editing. Without altering the structure of the 
statements or atomlists involved, you can easily edit this IF  statement, or duplicate it 
to have your avatar don different props in response to different trigger statements. Be 
sure your new prop names refer to actual props in your satchel, or your script will do 
nothing. You can also change the number of ticks between donning and doffing the 
prop.

FINGER information. We know the INCHAT handler isn’t done yet, because our first 
open-curly bracket in the cyborg.ipt  file hasn’t been matched with a close-curly 
bracket. The next section, therefore, is also executed on response to INCHAT...

; this is your FINGER information - replace the stuff in quotes with 

; information about yourself.

{

"^<insert name>\x0d"

"<insert e-mail>\x0d" +

WHOCHAT PRIVATEMSG

} CHATSTR "finger" == CHATSTR ";finger" == OR 

  WHOCHAT WHOME == NOT AND IF

}

As the comment tells us, this routine allows you to provide others with some 
information about you when they select you for whisper mode and say “finger”. To 
edit it, simply replace <insert name>  and <insert e-mail>  (including the angle 
brackets) with whatever information you want to put there. If you want to add 
additional information lines, copy the format of the "<insert e-mail>\x0d" +  
(including the plus sign at the end). Unless you’re an Iptscrae expert, you should 
probably leave the rest of this structure alone.

The OUTCHAT handler

If you pair up the curly brackets here you will find that the last one is an extra; we now 
know that we have reached the end of our INCHAT handler. The next block of 
statements comprise the OUTCHAT handler.
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ON OUTCHAT 

{

; more expressive prop changes (in response to what YOU say)

{

{ "Lightbulb" DONPROP { DOFFPROP } 120 ALARMEXEC } 30 ALARMEXEC

} CHATSTR "a.* idea" GREPSTR IF

This is the beginning of your OUTCHAT handler, which contains atomlists that execute 
whenever you say something.  The IF  statement is very similar to the one encountered 
in the INCHAT handler. In this example, the IF  statement evaluates each of your 
outgoing messages to see if it matches the specified target condition (the "a.* idea" ), 
and executes a don/doff  routine if it does.

The “a.* idea”  target condition looks for the letter a, followed by anything, followed 
by the word idea , anywhere in the outgoing message (GREPSTR instead of SUBSTR). 
Phrases like a good idea  and I have an insane idea, man  meet this criteria, and 
will trigger the Lightbulb  prop routine.

ZAP routine. Your OUTCHAT handler also contains a ZAP routine:

; Zap somebody by positioning the mouse and then say "zap"

{ "!)fazein Zap!" MOUSEPOS SAYAT

   255 0 0 PENCOLOR 2 PENSIZE 

   POSX POSY MOUSEPOS LINE 

   PAINTUNDO

  "" CHATSTR =

} CHATSTR "zap" == IF

This zap routine listens for you to say zap , whereupon it quickly performs a series of 
related actions:

1. It plays the fazein  audiofile and places the word Zap!  in a spiky balloon at the 
position of the mouse pointer ( "!)fazein Zap!" MOUSEPOS SAYAT ).

2. It sets the system pen to bright red (255 red, 0 green and 0 blue), and makes it two 
pixels wide ( 2 PENSIZE ).

3. It draws a line (using the pen's current color and size) from your avatar’s position 
( POSX POSY ) to the mouse pointer ’s position ( MOUSEPOS ). This creates a laser 
beam effect.

4. It erases the line ( PAINTUNDO ).

5. It removes your “zap”  statement from the CHAT string, so no one sees it 
( "" CHATSTR = ).

There have been so many variations on this script that it would take a good-sized 
document to list them all. The Zap script is probably the most heavily-edited atomlist 
in the Iptscrae annals. For starters, you might want to experiment with changing the 
target message and the audiofile played, or the color and size of the pen.
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Cleaning your room. The next atomlist is useful when a room gets too cluttered to see 
what’s going on.

; clean the room by saying "clean"
{

CLEARLOOSEPROPS
PAINTCLEAR

} CHATSTR "clean" == IF

This atomlist waits for you to say clean , and then removes all loose props from the 
current room ( CLEARLOOSEPROPS ) and deletes all painted lines on the screen 
(PAINTCLEAR ). 

Spoofing. The next statement is a spoofing atomlist.

; spoof somebody by positioning the mouse on their mouth
; and then typing "msay blah blah"

{ "$1" GREPSUB chatter =
  chatter MOUSEPOS SAYAT
  "" CHATSTR =
} CHATSTR "^msay (.*)$" GREPSTR IF

If you’re into spoofing people (putting words in their mouths), this atomlist makes it a 
lot easier than using the *X,Y function. It waits for you to say anything that starts 
with the word msay. When you do, everything after the word msay is sent to a cartoon 
balloon that magically appears at your cursor's position. It then sets the CHAT string to 
(nothing) so that no one sees your original utterance. This is such a useful routine that 
you should probably keep it just the way it is.

Final OUTCHAT atomlist. Here is the final atomlist in your OUTCHAT handler:

; give another user a prop

{ "$1" GREPSUB who = "$2" GREPSUB prop =

  prop who WHOPOS ADDLOOSEPROP

} CHATSTR "^give (.*) (.*)$" GREPSTR IF

}

We can tell this is the last statement because of the extra closed-curly bracket at the end 
of the sample (which matches the one we encountered on the first line of this handler). 
The routine waits for you to say anything matching the structure of give person  

prop . The first word after give  is called and passed to a symbol called who, while the 
final word is called $2 and is passed to a symbol called prop . A copy of prop  is then 
added to the screen at the position of who. This cannot be used to place a prop on a 
person, but rather puts it right next to them. 

NOTE – If the user specified is not present in the room or the prop named is not in 
your prop file, this routine will not work.
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SIGNON handler

Finally, we come to the last handler in your cyborg.ipt file:

ON SIGNON {
"*64,64 !It's " USERNAME + SAY
1 MACRO

}

This is your ON SIGNON handler, which consists of only one atomlist. When you first 
enter any Palace site, this routine does two things. First it causes you to say 
It’s your_name ! in a spiky balloon at position 64 x 64 on the screen. Next it runs 
"macro" number 1, setting your initial appearance (this is equivalent to selecting the 
first avatar from the Avatars window, or pressing the F1 key).

You’ll notice that the syntax and special characters used to indicate the location and 
style of the announcement are the same as those used in the Input Box to create special 
talking effects. By experimenting with these text-based functions (and the others 
available via the Input Box) you can edit this script to trigger complex strings of text, 
sound and avatar actions whenever you enter a Palace site.
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Welcome to the Palace! Once you’ve installed the software, you’re ready to meet people 
and explore Palace sites. Here are some suggestions on what you can do to get going:

What to do How to do it

Log on for the first time Logging on for the first time on page 13

Connect to a Palace Connecting to Palace Sites on page 17

Ask a Palace operator for help Paging an operator on page 33

Change your name Changing your name on page 23

Customize your roundhead 
avatar

Customizing your roundhead avatar on page 24

Get a new avatar Creating a new avatar on page 27

Send messages to people Talking to people on page 30

Have a private conversation Whispering and ESP (private messages) on 
page 32

Change your balloon Special balloons on page 31

Find other people Finding people on page 33

Join somebody else Joining another user on page 35

Move around within your room Click on the spot where you want to go

Find doors and hot spots to 
other places

Spots and doors on page 35

Go to another room Jumping to a specific room on page 35 and 
Going forward and backwards on page 36

Use props General prop actions on page 37

Create or edit a prop Creating and editing props with the prop editor 
on page 37
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Play sounds Playing sounds on page 34

Use special shortcut keys Hotkey combinations on page 53

Use special member commands Palace Command Summary on page 81 and 
Creating and maintaining your own room on 
page 69.

What to do How to do it
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Standards

After the interface explanations and Iptscrae examples are over, after you’ve become 
confident in your use of Palace and after all the tricks have been taught, there are still 
several important topics that cannot be brushed aside, all of which come down to the 
way people treat each other in the Palace community.

As a new breed of endeavor somewhere between concrete art and abstract science, it is 
certain that the school of virtual environment design still has a long way to go before it 
reaches anything approaching maturity. Unfortunately, the same can be said for a lot of 
people, even out here on the electronic frontier. It takes all kinds, right? Anyway, in 
your travels through the various worlds of The Palace it is not unreasonable to assume 
that you’ll run into a few troublemakers. These people enjoy pushing others for a 
reaction, and their antics tend toward garden-variety spoofing and gutter-variety 
profanity. Alone or in small groups, these cyber-brats often hop from room to room, 
looking for new people to offend.

If you find yourself in such a situation, there are a number of things you can do to 
make it stop (and/or keep it from happening again). But because you do have real 
recourse to real solutions, you need to ask yourself whether this represents truly 
offensive behavior (i.e., such as most people would find offensive), or whether this 
person is simply making momentary use of a Palace feature in a unusually “creative” 
way. Sometimes that line can be hard to draw; even harder when your own emotions 
get into the equation.

It is important not to react in kind when confronted with rude or obnoxious behavior; 
nothing encourages it more. Rather, you should seek at first to distance yourself from 
the offending person. There’s a lot of room out there, and plenty nicer people to hang 
out with. You can always sign off and come back later; disconnection is the better part 
of virtual valor. If the person persists in bothering you, open your log (under the File 
Menu) — it may help later to have a record of their exact words.

Of course, you can always call for divine intervention... At most Palace sites, the 
operators and owners are creative and dedicated people; they create virtual worlds to 
share enjoyable experiences with others like themselves, not to sink to the lowest levels 
of human behavior. And since they all want their sites to be popular, it’s in their 
interest to make sure people feel comfortable during their visit. Within their own sites, 
operators and owners are all-powerful; able to create and destroy rooms, distribute and 
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revoke passwords, and temporarily “kill” or indefinitely “ban” specific individuals (or 
entire domains). If you feel that a certain individual is acting in such a way as to ruin 
the experience for others, let the local deities know about it. That's probably all you'll 
need to do.

The Palace is not the first graphic multi-user domain ever created, but it is probably 
the least strict. Many powers possessed by the average Palace member — painting, 
spoofing and nickname-changing, to name a few — would be withheld for operators 
and owners only on MUDs of other varieties. The way we decide to handle these 
powers determines to a great degree what kind of community we are. These powers 
have been given to all of us as a design decision on the part of The Palace Inc., but it is 
important to remember that it’s all software; should certain powers prove 
unmanageable or harmful, they may be crippled or removed entirely from subsequent 
versions.

In a way, the whole of the Palace community can be seen as a massive, progressive 
social experiment in which we are all participating. For this reason, we invite you to 
participate in the “Community Standards” Discussion Group. To get there, take your 
web browser out to the "Palace Support" section of The Palace website (http://
www.thepalace.com) and click on the link labeled “Discussion Forums."

Please post your experiences, insights and suggestions for the benefit of all Palace 
users.
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 B Palace  Command 
Summary

The following table provides a list of all special commands (not counting Iptscrae 
commands and keywords):

• Guest commands on page 81

• Member commands on page 82

• Operator commands on page 83

• Owner commands on page 85

NOTE – These commands are current for the Palace Server version 4.4.1. Note that 
some commands are not available on older versions of the Palace server.  For the list of 
which commands are available on the specific server you are connected to, use the 
’help  command.

Guest commands

The following table lists the Palace guest commands.

Guest 
Commands

Syntax Description

help ' help Displays all special commands available to your 
user class, in the Log window

page 'page message Summons help from an operator

sitepage 'sitepage Displays the URL of this Palace’s Site page.
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Member commands

The following table lists the Palace member commands.

Member 
Commands

Syntax Description

hide 'hide on
'hide off

Hides you from all other users
Unhides you from all other users

hidefrom 'hidefrom name Hides you from user name

mute `mute name Mutes user name

newroom 'newroom 
'newroom [roomName]

Creates your member room (one per user)
Creates your member room as roomName

page 'page message Summons help from an operator

password 'password password Specifies a password for navigation purposes

rclose 'rclose Closes your member room to further visitors

rdelete 'rdelete Deletes your member room

re
respond

're message 
'respond message

Replies to the last sender of an ESP message

rejectesp 'rejectesp on 
'rejectesp off

Rejects all incoming ESP messages
Stops rejecting ESP messages

rejectprivate 'rejectprivate on 
'rejectprivate off

Rejects all incoming private messages
Stop rejecting private messages

rguests 'rguests on 
'rguests off

Allows guests to enter your member room
Prohibits guests from entering your member 
room

rhide 'rhide on
'rhide off

Hides your member room from the Room List
Unhides your member room from the Room List

rkick 'rkick name Kicks name out of your member room

rname 'rname roomName Renames your member room as roomName

ropen 'ropen Opens your member room to visitors

rowner 'rowner name Transfers ownership of your member room to 
user name

rpainting 'rpainting on 
'rpainting off

Enables painting in your member room
Disables painting in your member room

rpassword 'rpassword [password] Password-protects your member room

rpicture 'rpicture filename Sets new background for your member room
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Operator commands 

Operator commands

The following table lists the Palace operator commands.

rscripts 'rscripts on 
'rscripts off

Enables scripts in your member room
Disables scripts in your member room

runhide 'runhide Same as `rhide off

runkick 'runkick name Cancels an `rkick command

unhide 'unhide Same as `hide off

unhidefrom 'unhidefrom name Unhides you from user name

unmute 'unmute name Unmutes user name

Operator 
Commands

Syntax Description

autoannounce 'autoannounce message Sets the server greeting to message

banip 'banip [minutes] 
ipAddress

Bans one or more IP addresses for minutes.  
May use wildcards (i.e.: 12.24.23.*).

banlist 'banlist [-k] [-a] 
[name|ipAddress]

Shows banned users in log window

banuser 'banuser [minutes] name Bans user name for minutes

bots 'bots on
'bots off

Turn user scripts on server-wide
Turn user scripts off server-wide

comment 'comment ipAddress 
message

Adds a comment to a banlist

death 'death minutes Set default death penalty to minutes

delete 'delete Deletes the current room

duplicate 'duplicate Duplicates the current room

er 'er Moves you to the room of the last (non-
operator) page

extend 'extend string minutes Extends the death penalty on a ban record

flood 'flood number Kill flooders after number events per second

gag 'gag name Gags user name

Member 
Commands

Syntax Description
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glist 'glist [-k|-o| -p| -wl] Lists information on all users
• -k Show the users’s reg key hash
• -o Show the users’ software originiation 

code and machine type
• -p Show the users’ PUID hash
• -w List only operators

kill 'kill [minutes] name Kills (disconnects) user name for minutes

list 'list [-k|-o| -p| -w] 
[name|ipAddress]

Lists information on specific user matching 
name or IP address
• -k Show the users’s reg key hash
• -o Show the users’ software originiation 

code and machine type
• -p Show the users’ PUID hash
• -w List only operators

operatorcount 'operatorcount Displays the number of operators currently 
logged in.

paint 'paint on
'paint off

Turns painting on server-wide
Turns painting off server-wide

pin 'pin name Pins user name

propgag 'propgag name Propgags member name

purgebanlist 'purgebanlist Purges elapsed ban records

purgeprops 'purgeprops number Purges all props older than number days

repage 'repage message Sends message to the last (non-operator) page

roommaxguests 'roommaxguests 
number

Sets the max guest occupancy for the current 
room

roommaxocc 'roommaxocc number Sets the max occupancy for the current room

track 'track [minutes] name Tracks all sign-ons from user name for minutes

trackip 'trackip [minutes] 
ipAddress

Tracks all sign-ons from ipAddress.  May use 
wildcards (i.e.: 12.24.23.*).

unban 'unban name
'unban ipAddress

Unbans user name
Unbans user from ipAddress

ungag 'ungag name Ungags user name

unpin 'unpin name Unpins user name

unpropgag 'unpropgag name Unpropgags member name

untrack 'untrack name
'untrack ipAddress

Stops tracking user name
Stops tracking user from ipAddress

Operator 
Commands

Syntax Description
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Owner commands 

Owner commands

The following table lists the Palace owner commands.

Owner 
Commands

Syntax Description

allowedurls 'allowedurls on
'allowedurls off
'allowedurls "URL"

Enables the allowed URLs string.
Enables the allowed URLs string
Sets the allowed URLs string or strings 
(separated by a pipe (|)).

authoring 'authoring on
'authoring off

Allows operators to enter Authoring Mode
Prevents operators from entering Authoring 
Mode

avatarurl 'avatarurl on
'avatarurl off
'avatarurl "URL"

Sets custom avatars on.
Turns custom avatars off.
Sets the avatar directory to the designated 
URL.

ban 'ban name Permanently banishes name from the server

botkill 'botkill on
'botkill off

Allows cyborg scripts to kill
Prevents cyborg scripts from killing

chatlog 'chatlog on
'chatlog off [filename]

Enables chat logging on the server
Disables chat logging on the server

custom 'custom on
'custom off

Enables custom props on the server
Disables custom props on the server

defaultroomocc 'defaultroomocc 
number

Sets the default room occupancy

downlist 'downlist number Moves the current room number positions 
down in the script file

dropzone 'dropzone Makes the current room a dropzone (front 
gate)

entrypage 'entrypage ["URL"] Sets the Palace’s default entrypage URL for 
the Palace Directory. If keyword 
FORCETPVWEBPAGE is set, it’s also the 
entry page for web clients coming in from a 
non-authorized URL  (TPVALLOWEDURLS 
keyword).

fileserver 'fileserver ["URL"] Sets the location of your media for web-based 
users.

flushprops 'flushprops n Clears old props older than n days and 
compresses the prop file.

guests 'guests on
'guests off

Enables guest access to the server
Prevents guest access to the server
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killprop 'killprop Removes the prop you are wearing from the 
server prop file.

maxocc 'maxocc number Sets the maximum server occupancy

memberrooms 'memberrooms on
'memberrooms off

Allows members to create member rooms
Prohibits creation of member rooms

nowhisper 'nowhisper on
'nowhisper off

Disables whispering
Enables whispering

operators1 'operators on
'operators off

Enables support for operators
Disables support for operators

operatorskill 'operatorskill on
'operatorskill off

Allows operators to kill
Prohibits killing by operators

operatorsonly 'operatorsonly on
`operatorsonly off

Sets the current room as operator only
Removes operator-only setting

operatorpass 'operatorpass password Sets the operator password to password

ownerpass 'ownerpass password Sets the owner password to password

passwordsecurity 'passwordsecurity Enables password security (auto-kills after 
three failed password attempts)

picdir 'picdir path Sets the source directory for outbound files to 
path

pinprop 'pinprop 
'pinprop on
'pinprop off

Sets the pin prop to the prop you are wearing
Turns pin propping on
Turns pin propping off

playerkill 'playerkill on
'playerkill off

Allows members to kill
Prohibits killing by members

poundprotect 'poundprotect on|off Enables/disables pound protection. This logs 
the IP address of a user who repeatedly makes 
new connections in a short time interval.)

poundcheckinterval 'poundcheckinterval n Sets the pound check interval to n seconds.

propcontrol 'propcontrol on

'propcontrol off
'propcontrol userlevel

Turns on prop control (only owners can 
introduce new props)
Turns off prop control
Lets only userlevel users introduce new props

purgelimit 'purge number
'purgelimit number

Sets the purge limit to number days
Same as `purge number

recycle 'recycle [number] Causes guest ID numbers to recycle at number 

reportprefs 'reportprefs Lists the current Palace preferences.

reset 'reset Recomputes all rooms’ occupancy count.

revision 'revision Displays the Palace server version number.

Owner 
Commands

Syntax Description
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Owner commands 

1. Be careful in using this command. If you turn this off, and then log off, you will not be able to 
access the  operator interface again later to turn it on/off. You will need to use the 
~susr ownerpassword  command to get back into owner mode.

roomsfile 'roomsfile
'roomsfile .patfilename

Shows current file setting
Causes your Palace to use the template 
asociated with the named configuration file. 
This changes the look and feel of your Palace.

savesessionkeys 'savesessionkeys on
'savesessionkeys off

Enables/disables saving sessions keys (that is, 
logs users’ ID and reg code to the server log).

securejavaaccess 'securejavaaccess on
'securejavaaccess off

If this is on, additional authorization is 
required for web-based users.

securelogoff 'securelogoff on|off If this is on, the authentication engine tracks 
logoffs

securesite 'securesite on|off If this is on, a name and password are 
required to access this Palace server.

security 'security 
authhost:[authport] 
[retrys]|off

Sets the security (authentication) daemon.
• authhost is the daemon’s URL
• authpot is the daemon’s port
• retrys specifies how many attempts a user 

can make. The default is 1.

setrank 'setrank command 
setting

Sets the rank of the command to the specified 
setting.

servername 'servername string Sets the servername to string

showranks 'showranks Displays each Palace command and its current 
rank. Modifications via 'setrank are shown in 
paranthesis.

shutdown 'shutdown Shuts down the server

spoof 'spoof on
'spoof off

Allows members to spoof using @x,y 
commands
Prohibits spoofing

uplist 'uplist number Moves the current room number positions up 
in the script file

Owner 
Commands

Syntax Description
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 C The Palace Client 
Plugin API

The Palace client software has an open architecture that makes it possible for other 
programs, such as games, to plug-in. If you're interested in finding out more in joining 
the developer's program, please go the Partner's page on The Palace website 
(www.thepalace.com ).
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A
Activate Membership 45
Add Bookmark 51
Allow Animation 47
America Online 19
animate avatar 25
animated props 47
animation 57
Autoshow Names 47
avatar

animate 25
balloon types 31
change appearance 13, 14, 25
change color 23, 52
change expression 23, 52
change name 23, 52
create 27
create room 69
customize 24
definition 13, 21
display names of 47
edit profile page 26
enter whisper mode 22
find 48
join other user 35
move around 15, 35
multiple-prop 28
mute 22
pop-up menu 22
profile page 46
save look 29, 52
see somebody’s profile page 26
set name 46
show names 22, 43
single-prop 27
talk to people 14, 30
unmute 22
wear look 29

Avatar Dispenser 13
Avatar Palace 14
Avatars Menu 52
Avatars window 29, 44, 52

B
balloon 31

access from Toolbox 42
change font and font size 31
color 47
spoofing 32
types 31

Balloon Delay 47
bookmark 18, 19

add 51
Bookmarks Menu 51
Bookmarks window 51
Bounce 57

C
change

avatar look 24
avatar name 23
color 23
expression 23
font 47

Change Avatar Name menu item 52
Channel Guide 14, 51
Child Lock 45
Choose an Avatar window 23, 43, 52
Clear Log 46
Close Log File 44
color, change 23
commands 69, 81
Compress Prop File 45
CompuServe 19
Connect to a Palace 44
Connect To A Palace button 42
connecting

returning to recently-visited Palace 19
through online services 19
through web browser 18
to other Palace sites 18
to Palace sites 17

connection window 17
conversation 30
copy

prop 36, 37
text 45

create
new avatar 27
prop 38

customize avatar 24
cyborg.ipt file 72

D
default connection Palace 18
delete prop 36, 37, 44
directory of Palaces 18
disconnecting 15, 44
door 35

Show Doors button 43
show outlines 35

Download Graphics menu item 47
Draw 50

E
Edit Menu 45
Edit Profile Page 46
edit prop 37
ESP 32
expression

change 23
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F
Face button in toolbox 43
FAQ, access 53
File Menu 44
Find User 48
font

change 47
in balloons 31

font size, in balloons 31

G
ghost prop 57
Go Back button 42
Go Back menu item 48
Go Forward button 42
Go Forward menu item 48
Goto Room 35, 49
GoTo Site Page 49
graphics

black room art 47
download 47

Guest Avatars menu option 52

H
head prop 27, 57
Help Menu 53
Home Palace 18
hot spots 18
hotkey combinations 53

I
initial logon 13
Input Box 43
installation 12

updating software 12
interface 39
Iptscrae 72

J
join other user 35

L
log file, open and close 44
Log window 32, 50

clear 46
log window button 42
logging off 15
logging on 13

M
main window 39
membership 12
Microsoft Network 19
move prop 37
moving around 15, 35

Go Back 48
Go Forward 48
join user 35
jump to specific room 35
return to previous rooms or Palaces 36

multiple prop avatar 28
mute avatar 22

N
name 46

change 23
displays avatars 47

newroom command 70

O
object, see prop
Open Log File 44
operator 33

enter password 51
Operator Menu 52
Operator Mode menu item 51
Options Menu 48
owner, enter password 51

P
page, operator 33
Paint Window button 43
painting 43, 50
Palace 18

commands 81
go forward and backward 36
site page 49

Palace client 17
connecting through online services 19
connecting through web browser 18
connection window 17
hotkey combinations 53
interface 39
logging off 15
logging on for first time 13
main window 39
Palace Directory 51
Palace Presents Viewer 59
participate in auditorium events 60
plugins 52
Practice Palace 14
preferences window 15, 46
requirements 11
returning to recently-visited sites 19
set default 47
set password 45
special commands 69
Toolbox 41
update 53
updating software 12
using Palace Directory 18

Palace Directory 51
Palace Presents Viewer 59
Palace site, Channel Guide 51
Palace sites

connecting to 17
Palace Directory 51

Palace Starts With 47
palace.prp 45
password, set for children 45
Paste Multiple Props 28, 46
paste text 45
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playing sound 34, 48
Plugins Menu 52
Practice Palace 14
preferences window 15, 46
profile page 26

edit 46
prop

actions 37
bounce 57
copy 36
copy and wear 36
create animation for 57
create loose 37
create new 38
create rare 57
definition 36
delete 36, 37, 44
edit 37
ghost 57
move 37
paste multiple 46
pop-up menu 36
put copy in prop window 37
put in prop window 37
put on 37
take 36
view animated 47
wear 36, 37

prop editor 37, 55
prop file, compress 45
prop window 36, 51

suitcase 44

R
rare prop 57
rclose command 71
rdelete command 70
Reload Script 45
requirements 11
return to a Palace site 19
rguests command 71
rhide command 71
rkick command 70
rname command 70
room

black background 47
create and maintain 69
go to 49
jump to 35

room drawing tools 43, 50, 54
Room List window 35
ropen command 71
rowner command 70
rpainting command 71
rpassword command 71
rpicture command 70
rscripts command 71
runhide command 71
runkick command 70

S
satchel 36
Save Avatar 44

save avatar look 29
Save/Wear avatars 29
script, reload 45
server, connecting to 17

setting default to connect to 18
shortcut keys 53
shout balloon 32, 42
Show Doors button 43
Show Guests in User List 47
Show Names 48
Show Names button 43
Show Tooltips 47
sign balloon 31
sign balloon button 42
single-prop avatar 27
site page, go to 49
Software Update menu item 53
sound

button 42
play 48
playing 34
turn on/off 48

Sound On/Off 48
special balloon 31
special commands 69
spoof 32
spots 35
Status Bar 43
suitcase 36
Suitcase icon 44

T
talk 14, 30

log window 32
to people in other rooms 32

talk balloon 31
Talk Balloon button 42
text

copy 45
cut 45
paste 45

thought balloon 31
button 42

Tinted Balloons 47
Toolbox 41

open/close 50
tooltips 47
Trash Can icon 44
travelling 35
tutorial 14

U
unmute avatar 22
update software 12, 53
User Guides, access 53
User List window 35, 48
User Name 46

V
View screen 39
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W
wear avatar look 29
wear prop 37
web browser 18
Welcome Palace 13
Welcome Palace Gate 13
whisper, to people in other rooms 32
whisper mode 32

enter with menu 22


